Color StyleWriter 1500
Setting up and using your printer
Color StyleWriter 1500
Setting up and using your printer
Apple Computer, Inc.

© 1996 Apple Computer, Inc. All rights reserved.

Under the copyright laws, this manual may not be copied, in whole or in part, without the written consent of Apple.

The Apple logo is a trademark of Apple Computer, Inc., registered in the U.S. and other countries. Use of the “keyboard” Apple logo (Option-Shift-K) for commercial purposes without the prior written consent of Apple may constitute trademark infringement and unfair competition in violation of federal and state laws.

Every effort has been made to ensure that the information in this manual is accurate. Apple is not responsible for printing or clerical errors.

Apple Computer, Inc.
1 Infinite Loop
Cupertino, CA 95014-2084
(408) 996-1010

Apple, the Apple logo, AppleShare, AppleTalk, ColorShare, ColorSync, EtherTalk, LaserWriter, LocalTalk, Macintosh, Macintosh Quadra, Mac X25, New York, PowerBook, QuickTake, StyleWriter, TokenTalk, TrueType, and Zeal are trademarks of Apple Computer, Inc., registered in the U.S. and other countries.

Chicago, the Dogcow logo, Finder, Geneva, Mac, Monaco, and QuickDraw are trademarks of Apple Computer, Inc.

Classic is a registered trademark licensed to Apple Computer, Inc.

Adobe, Adobe Illustrator, Adobe Photoshop, Adobe Type Manager, PostScript, and SuperPaint are trademarks of Adobe Systems Incorporated or its subsidiaries and may be registered in certain jurisdictions.

Helvetica, Palatino, and Times are registered trademarks of Linotype-Hell AG and/or its subsidiaries.

ITC Avant Garde, ITC Bookman, ITC Garamond, ITC Lubalin Graph, ITC Machine, ITC Zapf Chancery, and ITC Zapf Dingbats are registered trademarks of International Typeface Corporation.

Simultaneously published in the United States and Canada.

Mention of third-party products is for informational purposes only and constitutes neither an endorsement nor a recommendation. Apple assumes no responsibility with regard to the performance or use of these products.
Contents

Communications regulation information vii

Welcome ix
Main features of the Color StyleWriter 1500 ix
Changes to the printing software that affect other printers x
System requirements x

1 Setting Up Your Printer 1
Important safety instructions 1
Unpacking the printer 3
Getting acquainted with the Color StyleWriter 1500 4
Power Macintosh users and Virtual Memory 5
Installing the ink cartridge 6
Connecting the printer to your Macintosh 9
Plugging in the printer 10
Turning the printer on and off 11
Installing your printer software 14
Telling your computer to use the Color StyleWriter 1500 17
Printing a document to make sure everything's working 19
Checking the print nozzles 21
What's next? 22
2 Printing 23
Planning documents with the Color StyleWriter 1500 in mind 23
Loading the sheet feeder 24
Printing a document 27
Adjusting color options 32
Creating special effects on the Color StyleWriter 1500 34
Switching between printers 38
Creating, throwing away, and manipulating desktop printer icons 40
Determining the status of a printer by looking at its icon 40
Printing while you use your computer 41
Monitoring and controlling background printing 42
Using ColorShare to share your printer with other users 44
Printing on a shared Color StyleWriter 1500 47
Connecting a Color StyleWriter 1500 to an EtherTalk network 48

3 Tips on Paper, Quality, Speed, and Cost 49
Choosing print materials 49
Quality 51
Speed 52
Cost 52

4 Maintaining Your Printer 53
Replacing an ink cartridge 54
Storing the cartridge you aren't using 55
Cleaning the outside of the printer 57
Cleaning the inside of the printer 57
5 Troubleshooting  59

Safety precautions  60
The Chooser doesn't show the Color StyleWriter 1500 icon  60
Installation is unsuccessful  60
The computer crashes while attempting to print  63
A Power Macintosh has trouble printing to the Color StyleWriter 1500  63
A PowerBook has trouble printing to the Color StyleWriter 1500  63
The Macintosh doesn't recognize the Color StyleWriter 1500  64
Desktop printer icons behave unusually  65
The power light indicates a problem  66
The printer seems slow  66
Paper is jammed  67
More than one piece of paper passes through the printer at a time  67
Paper or envelopes feed improperly  68
The Color StyleWriter 1500 won't print a particular document  69
The printer acts as if it's working, but nothing is printed on the page  70
Messages appear on your computer screen  70
Memory is low  72
Documents did not print as expected  73
Print quality is poor  76
Ink cartridges run out of ink too quickly  80
<table>
<thead>
<tr>
<th>Appendix</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Technical Information</td>
<td>81</td>
</tr>
<tr>
<td>B</td>
<td>Using Fonts With the Color StyleWriter 1500</td>
<td>87</td>
</tr>
<tr>
<td>C</td>
<td>Font List</td>
<td>101</td>
</tr>
<tr>
<td>D</td>
<td>Working With ColorSync</td>
<td>103</td>
</tr>
<tr>
<td>E</td>
<td>Printing with QuickDraw GX</td>
<td>107</td>
</tr>
<tr>
<td>F</td>
<td>Removing the Desktop Printing Software</td>
<td>117</td>
</tr>
<tr>
<td>G</td>
<td>Packing and Moving the Printer</td>
<td>121</td>
</tr>
<tr>
<td></td>
<td>Index</td>
<td>123</td>
</tr>
</tbody>
</table>
Communications regulation information

FCC statement

This equipment has been tested and found to comply with the limits for a Class B digital device in accordance with the specifications in Part 15 of FCC rules. See instructions if interference to radio or television reception is suspected.

Radio and television interference

The equipment described in this manual generates, uses, and can radiate radio-frequency energy. If it is not installed and used properly—that is, in strict accordance with Apple’s instructions—it may cause interference with radio and television reception.

This equipment has been tested and found to comply with the limits for a Class B digital device in accordance with the specifications in Part 15 of FCC rules. These specifications are designed to provide reasonable protection against such interference in a residential installation. However, there is no guarantee that interference will not occur in a particular installation.

You can determine whether your computer system is causing interference by turning it off. If the interference stops, it was probably caused by the computer or one of the peripheral devices.

If your computer system does cause interference to radio or television reception, try to correct the interference by using one or more of the following measures:

- Turn the television or radio antenna until the interference stops.
- Move the computer to one side or the other of the television or radio.
- Move the computer farther away from the television or radio.
- Plug the computer into an outlet that is on a different circuit from the television or radio. (That is, make certain the computer and the television or radio are on circuits controlled by different circuit breakers or fuses.)

If necessary, consult an Apple-authorized service provider or Apple. See the service and support information that came with your Apple product. Or, consult an experienced radio/television technician for additional suggestions.

IMPORTANT Changes or modifications to this product not authorized by Apple Computer, Inc., could void the FCC Certification and negate your authority to operate the product.

This product was tested for FCC compliance under conditions that included the use of Apple peripheral devices and Apple shielded cables and connectors between system components. It is important that you use Apple peripheral devices and shielded cables and connectors between system components to reduce the possibility of causing interference to radios, television sets, and other electronic devices. You can obtain Apple peripheral devices and the proper shielded cables and connectors through an Apple-authorized dealer. For non-Apple peripheral devices, contact the manufacturer or dealer for assistance.
DOC statement

DOC Class B Compliance  This digital apparatus does not exceed the Class B limits for radio noise emissions from digital apparatus as set out in the interference-causing equipment standard entitled “Digital Apparatus,” ICES-003 of the Department of Communications.

Observation des normes—Classe B  Cet appareil numérique respecte les limites de bruits radioélectriques applicables aux appareils numériques de Classe B prescrites dans la norme sur le matériel brouilleur: “Appareils Numériques”, NMB-003 édictée par le ministre des Communications.

VCCI statement

情報処理装置等電波障害自主規制について

この装置は、第二種情報装置（住宅地域又はその隣接した地域において使用されるべき情報装置）で住宅地域での電波障害防止を目的とした情報処理装置等電波障害自主規制協議会（VCCI）基準に適合しております。

しかし、本装置をラジオ、テレビジョン受信機に近接してご使用になると、受信障害の原因となることがあります。

取扱説明書に従って正しい取り扱いをしてください。
Welcome

Congratulations on your purchase of the Color StyleWriter 1500 printer. This book describes how to set up the printer and how to use it.

Main features of the Color StyleWriter 1500

- The Color StyleWriter 1500 quietly prints text and high-quality color graphics on a variety of materials, including plain paper.
- With the black ink cartridge, you get fast, laser-sharp black and white printing with 720 x 360 dpi edge smoothing for text and line art.
- The paper feeder handles plain or coated paper, transparencies, labels, or envelopes. It holds up to 100 sheets of paper or up to 15 envelopes.
- Desktop printing makes it easy to print existing documents, switch printers, or monitor your print requests.
- ColorSync compatibility provides the best possible match between the colors on your monitor and the colors that are printed.
- The printer software supports printing 2 or 4 reduced-size pages on a single sheet, making it easy to preview documents while saving paper, ink, and time.
- 64 available TrueType (outline) fonts print smoothly in a variety of sizes.
- An energy conservation feature turns off the printer when you aren't using it and turns it on automatically when you print something.
Changes to the printing software that affect other printers

If you use a printer that uses Apple's PrintMonitor application program, including all LaserWriter and all StyleWriter printers, please note the following changes:

- Your new printing software includes a feature called *desktop printing*, which gives you new ways to print from the desktop. For details, see “Desktop Printing” in the “Printing a Document” section in Chapter 2.
- You also use the desktop printing features (instead of Apple's PrintMonitor program) to monitor background printing. See “Monitoring and Controlling Background Printing” in Chapter 2.
- The Color StyleWriter 1500 software also works with the original StyleWriter, the StyleWriter II, and StyleWriter 1200 printers. Owners of the original StyleWriter can find the manual feed option by choosing the Print command and clicking the Utilities button in the dialog box that opens.

System requirements

To install the printer software and use the Color StyleWriter 1500 printer with your Macintosh computer, you need

- a Macintosh with a 68020 or higher central processing unit (CPU), any Macintosh except a Macintosh Plus, SE, Classic®, Portable, or PowerBook 100
- Macintosh Operating System (Mac OS) version 7.1 or a later version
- at least 4 megabytes of random-access memory (RAM); 5 megabytes or more is recommended
- some space available on your hard disk (during installation the Installer tells you if you need more disk space)

The Installer program that comes with the Color StyleWriter 1500 automatically checks whether your computer meets these requirements. Chapter 1 explains how to use the Installer program.
1 Setting Up Your Printer

This chapter introduces the Apple Color StyleWriter 1500 printer and explains how to set it up. After you follow the instructions in this chapter, you’ll be ready to print.

Before you begin: Make sure that your Macintosh computer is already set up and that you know the basics of its operation.

Important safety instructions

Always take the following precautions:

- Keep the printer cover closed when printing.
- Always turn off the printer before unplugging it.
- Keep ink cartridges away from children.
- Keep the printer away from sources of liquids, such as wash basins, bathtubs, and shower stalls.
- Protect the printer from dampness or wet weather, such as rain and snow.
- Read all the installation instructions carefully before you plug the printer into a wall socket.
- Keep these instructions handy for reference by you and others.
- Follow all instructions and warnings dealing with your computer system.
- Don’t use devices that produce open flames, such as Bunsen burners, near the printer.
- Don't use alcohol-based or ammonia-based cleaners on or around the printer.
- Always unplug the printer before cleaning it. (Use only the cleaning procedure recommended in Chapter 4.)
- Clean the outside of the printer with only a damp cloth and, if necessary, a mild soap or detergent. Be careful not to get liquid into the printer or the power cord receptacle.

**IMPORTANT** The only way to disconnect power completely is to unplug the power cord. Make sure at least one end of the power cord is within easy reach so that you can unplug the Color StyleWriter 1500 when you need to.

**Watch for these situations, and if one occurs pull the plug!**
- the power cord or plug becomes frayed or otherwise damaged
- you spill something into the printer
- the printer is exposed to rain or any other excess moisture
- the printer has been dropped or otherwise damaged
- you suspect that your printer needs service or repair
- you want to clean the printer (use only the procedure recommended in Chapter 4)

**WARNING** Electrical equipment may be hazardous if misused. Operation of this product, or similar products, must always be supervised by an adult. Do not allow children access to the interior of any electrical product and do not permit them to handle any cables.
Unpacking the printer

1. Remove everything from the shipping box, but leave the ink cartridge in its package.

- Be sure to remove packing material from the sheet feeder.
- Be sure to open the printer’s front cover and remove the packing tape from inside.

![Diagram of a Color StyleWriter 1500 printer with various components labeled: Storage case, Software disks, Power cord, Apple System/Peripheral-8 cable, Black and color ink cartridges (leave them in the plastic tubs for now).]

2. Remove the tape and packing material from the inside and outside of the printer.
   
   Save the carton and the packing material in case you ever need to ship the printer. (See Appendix G, “Packing and Moving the Printer.”)

3. Close the printer’s cover.
4 Place the printer in your work area.

Choose a location near your computer that meets these requirements:
- a level (not slanted) surface near a grounded electrical outlet
- good ventilation
- out of direct sunlight
- never gets damp or very hot or very cold
- away from devices that could cause electromagnetic interference, such as stereo speakers or cordless telephone transmitters

See Appendix A, “Technical Information,” for specific information about the physical requirements of your printer.

IMPORTANT Don't accidentally discard the ink cartridge storage case. You need it to store an opened cartridge that you're not using in the printer. The case keeps the print head from drying out and prevents accidents with ink stains.

Getting acquainted with the Color StyleWriter 1500

Now that the printer is unpacked, take a look at it to familiarize yourself with its parts.

Front view

![Diagram of printer front view](image)
Power Macintosh users and Virtual Memory

If you are using a Power Macintosh computer, be sure to turn on Virtual Memory before you try to print on the Color StyleWriter 1500. Then choose a setting that's at least 1 MB higher than your “Available built-in memory.” (You can set it higher without any ill effects.) With this setting, you will avoid some potential printing problems. Turning on Virtual Memory also reduces the amount of memory needed by many applications. For instructions on turning on Virtual Memory, see the documentation that came with your computer.
Installing the ink cartridge

The ink cartridge contains the print head, which sprays ink onto the paper. Treat it gently so you don't damage its tiny nozzles (located under a bright orange cap).

1. Open the printer by pulling down its front cover.

**WARNING** The carrier holds the ink cartridge and moves it back and forth when you are printing a document. When the printer is plugged in, don't slide the carrier by hand or you may damage the printer.

2. Raise the bright blue lever on the carrier.

3. Remove the cover from the plastic tub that contains an ink cartridge.

   These instructions show the color cartridge being installed, but the process is the same for either cartridge.

4. Remove the ink cartridge from the plastic tub, grasping the cartridge by its sides.
5. Remove the bright orange cap from the cartridge's print head.

After you snap it off, dispose of the cap.

Be careful not to touch the nozzles, which are under the cap.

6. Peel the orange tape off the print head.
7 **Slide the ink cartridge into its place in the printer.**

Don't worry if the cartridge is tilted a little to the left for now.

![Cartridge](image)

**Note:** There are instructions inscribed inside the printer cover to remind you how to install either the color or black ink cartridge.

8 **Lower the blue lever to secure the ink cartridge in place.**

As you lower the lever, the cartridge straightens.

![Printer](image)

9 **Close the printer's front cover.**
Connecting the printer to your Macintosh

**IMPORTANT** Be sure you are using a serial cable, not a LocalTalk cable.

If your computer is connected to a network, a network cable may already be connected to the printer port (). In that case, use the modem port (ถอน).

If you have the optional EtherTalk Adapter, see “Connecting a Color StyleWriter 1500 to an EtherTalk Network” in Chapter 2.

Remember which port you use. Later, you must tell the printer software where to look for the printer.

Some PowerBook computers that have an internal modem installed cannot tell that the printer is connected to the computer. You must change a setting in the PowerBook Setup or Express Modem control panel. For details, see “Special Information for PowerBook Owners” in the section “Telling Your Computer to Use the Color StyleWriter 1500,” later in this chapter.
Plugging in the printer

Plug the connector end of the power adapter into the printer and then plug the other end of the adapter into an outlet.

First, insert the power cord here.

Then plug the power cord into an outlet or power strip.

IMPORTANT The only way to disconnect power completely is to unplug the power cord. Make sure that at least one end of the power cord is within easy reach so that you can unplug the printer in an emergency.
Turning the printer on and off

To turn the printer on (and off), press this button.

This light glows while the printer is on.

The first time you turn on the printer, you can hear the printer preparing itself for 15–20 seconds.

Saving energy

To save power, the printer turns itself off after sitting unused for about 5 minutes. As long as you leave it plugged into an active power outlet, the printer turns itself on automatically when you print something.

WARNING Except in an emergency, make sure the printer is turned off before you unplug it. (When the power light is off, the power is off.) If the printer is plugged into a power strip, never turn off the power strip unless you’ve already turned the printer off.

Each time you turn off the printer, or the printer turns itself off, it automatically moves the ink cartridge to the right, where it caps the nozzles to keep the ink cartridges from drying out. If you unplug the printer or discontinue power before turning it off, the printer can’t position the cartridge in the capped position, the print head may dry out, and you’ll have to replace the cartridge.
Loading paper into the sheet feeder

The sheet feeder holds up to 100 sheets of 20-pound paper and feeds the paper automatically into the printer. You can load many sizes of paper and other materials into the sheet feeder as described in Chapter 2, but to do a nozzle check, as described in the next section, you must use U.S. letter-size or A4 paper. To load paper into the sheet feeder, follow these steps:

1. **Open the printer cover.**
2. **Adjust the internal paper selector.**
   - For now, make sure the selector is in the left-hand position.
3. **Close the printer cover.**
4. **Adjust the external paper selector, as shown in the next step.**
   - Always adjust the external paper selector lever *before* loading the paper.
5 Load a stack of U.S. letter-size or A4 paper into the sheet feeder.

Instructions for loading paper correctly appear on the paper support. Information on the back of the paper tray shows you where to set the guide for different paper sizes.

- Slide this guide so it just touches the edge of the paper. If the stack of paper bows out even slightly, the guide is too tight.
- Extend this paper support. Make sure the paper extends above the support (and doesn't slide down inside the printer).
- Make sure the paper lines up evenly at this side of the feeder.
- Do not stack paper above this line (✓).
- Before loading the paper, make sure the external paper selector is next to the $ icon.
Installing your printer software

The disks that come with the Color StyleWriter 1500 contain the printer software and an Installer program that copies the software onto your hard disk. You need the printer software to use the printer. Before you can print your documents, you need to install the printer software on your Macintosh.

The Installer program installs the new printing software you need, plus any fonts that come with the printer (see Appendix C for a list of available fonts). If you use Apple's QuickDraw GX software, it will also install new QuickDraw GX software for the Color StyleWriter 1500.

Note: If you ever upgrade your system software (for example, from System 7.1 to System 7.5), you must reinstall the Color StyleWriter 1500 software.

Step-by-step installation instructions

These instructions tell you how to restart your computer with the extensions turned off (which prevents incompatible software from interfering with the installation) and how to use the Installer program.

Before you begin: Lock all the disks by turning each one over and sliding the small, square plastic tab in the corner so you can see through the hole. (The disks may already be locked.)

1 Quit any programs you are running.

2 While holding down the Shift key on the keyboard, choose Restart from the Special menu. Don’t release the Shift key until you see the “Extensions off” message on your screen.

3 After you see the Macintosh desktop, insert Color StyleWriter 1500 Disk 1 into a floppy disk drive.

4 To start the Installer program, double-click its icon.

You may have to open the disk icon to see the Installer icon.
5 In the Welcome dialog box that appears, click Continue.

IMPORTANT The Installer determines whether you have the correct system software, and enough memory and hard disk space to use this printer. If you do not, the Installer displays a message telling you what you need. You won't be able to install the printer software until you correct the system software or memory problem. If the message reports a problem, you can purchase new system software or memory from an Apple-authorized dealer, or free up space on your hard disk by throwing away files you don't need.

6 In the Installer dialog box, click Install.

Make sure the disk named here is the one on which you want to install the Color StyleWriter 1500 software. (If not, click Switch Disk.)

When you're ready to begin, click Install.

After a few moments, the Installer begins to install the printer software. A status box keeps you informed of progress during installation.

7 When you see a message on your screen, follow the directions and insert the next disk.

The Installer ejects disks and asks you to insert others. Keep following the instructions on the screen until the installation is complete.
When you see a message reporting that installation was successful, click Restart.

The Installer restarts your Macintosh. After you restart, you may notice a new icon on your desktop, one that represents a printer. It's called a desktop printer, and it looks like this. For information about desktop printers, see "Desktop Printing" (in the section “Printing a Document”) and “Monitoring and Controlling Background Printing” in Chapter 2.

Examples of desktop printer icons
(a bold outline indicates the selected printer)

Color StyleWriter 1500  LaserWriter

If this is your first printer, you won't see a desktop printer icon yet.

After the computer restarts, you must select the printer in the Chooser, as described in the next major section, "Telling Your Computer to Use the Color StyleWriter 1500."

Installation troubleshooting

If the Installer can't complete the installation, it will issue a warning message. Here are some ways to fix common problems.

- You may not have the correct hardware or system software for this printer. If so, the Installer will tell you what you're missing.
- You may have forgotten to turn off your software extensions as described in the previous section.
- You may have some corrupted fonts on your hard disk. To solve or work around this problem, see “Installation is Unsuccessful” in Chapter 5.

More information about the Installer program

In the procedure just described, the Installer copies all the software you need to your hard disk. In rare circumstances, you may want to copy only a subset of the software. In that case, choose Custom Install from the pop-up menu in the Installer. A list of choices appears. Select the items you wish to install, then click the Install button. (Click the letter i to the right of any of the choices for information.)
Telling your computer to use the Color StyleWriter 1500

Before using your printer, you must select it in the Chooser.

1. Select Chooser from the Apple () menu.

2. In the Chooser dialog box, click the appropriate items to select them.

On most Macintosh computers, the Chooser looks like this:

First, click this icon. (If you don't see the icon, use the scroll bar and arrows to find it.)

If your computer is connected to a network, the Chooser may look different, but you can still follow these steps.

Then click one of these items to indicate which port you connected the printer to: the printer port () or the modem port ().

If no port is available and your computer is a PowerBook, see the next section, “Special Information for PowerBook Owners.”

3. Close the Chooser by clicking its close box (in the top-left corner).

4. Notice the new desktop printer icon for the Color StyleWriter 1500.

After you close the Chooser, a desktop printer icon for the Color StyleWriter 1500 appears on the desktop.

Color StyleWriter 1500

This icon cannot be moved off the desktop (unless you throw it away); however, you can move it anywhere on the desktop that you like.
Special information for PowerBook owners

PowerBook computers that have internal modems may require special setups. What you do depends on whether the PowerBook has one or two serial ports on its back panel.

PowerBook computers with one serial port

Some PowerBook computers have a single serial port identified by a combination printer/modem icon (\icon{Modem}/\icon{Printer}). If an internal modem is installed on one of these PowerBook computers, the serial port may be in use even though it looks available. When you plug in the Color StyleWriter 1500, the PowerBook may not be able to communicate with the printer.

To make the port available for printing, make sure the serial port setting is Normal or External. To check the setting, open the PowerBook, PowerBook Setup, or Express Modem control panel. (If you have another kind of internal modem, you may have a different control panel. The control panel and the setting you use depend on which PowerBook you have and which internal modem you have.) If you have a PowerBook Express Modem, it is best to leave the serial port setting as Normal or External unless the modem programs you use require another setting for compatibility reasons.

PowerBook computers with two serial ports

Even when a PowerBook has two serial ports, if it also has an internal modem, the modem port (~) may look available but actually be in use. If the printer port (~) is available, connect the Color StyleWriter 1500 to it. If the printer port is unavailable and you must use the modem port, make sure the modem serial port setting is Normal or External. To check the setting, open the PowerBook, PowerBook Setup, or Express Modem control panel. (If you have another kind of internal modem, you may have a different control panel. The control panel and the setting you use depend on which modem and system software version you have.) If you have a PowerBook Express Modem, it is best to leave the serial port setting as Normal or External.

For more information, see the instructions that came with your PowerBook.
Printing a document to make sure everything's working

The best way to see if your printer is set up correctly is to try printing something. The following steps describe how to print the Color StyleWriter 1500–Troubleshooting file that was installed on your hard disk, but you can print any document you want.

**Before you begin:** Return to the Finder by quitting any programs you're running.

1. **Find the Color StyleWriter 1500–Troubleshooting file.**

   Unless you moved it, you can find the file by double-clicking your hard disk icon.

2. **Open the file by double-clicking its icon.**

3. **Choose the Page Setup command from the File menu.**

   A dialog box opens.

4. **Indicate what paper size you're using.**

   First, use this pop-up menu to indicate the size of the paper loaded in the printer.

   ![Page Setup Dialog Box](image)

   Then click OK.

You don't need to choose the Page Setup command every time you print—you only need to use it when you want to change the normal settings. Look at the dialog box on your screen to note what the normal settings are. For information about the options in this dialog box, see “Printing a Document” and “Creating Special Effects on the Color StyleWriter 1500” in Chapter 2.
Choose the Print command from the File menu.

In the dialog box that appears, click the Print button.

For information about all the choices you can make in the Print dialog box, see "Printing a Document" and "Creating Special Effects on the Color StyleWriter 1500" in Chapter 2.

After a few moments, the printer begins printing the page or pages. If there’s a problem, see Chapter 5 for suggestions. (The most common problem is failing to follow the instructions in “Telling Your Computer to Use the Color StyleWriter 1500,” earlier in this chapter.)

Choose Quit from the File menu to leave the Color SW 1500–Troubleshooting file.
Checking the print nozzles

The Color StyleWriter 1500 prints by spraying ink onto the paper through tiny nozzles. Sometimes these small nozzles get clogged after sitting unused for a long time. To make sure all the nozzles are working, follow these steps.

1. If necessary, turn off the printer.
   The green power light should be off.

2. Press and hold down the power button for about 5 seconds.

3. Release the button and wait for the test page to print.
Examine the nozzle test pattern for broken or missing diagonal lines.

The nozzle test pattern appears near the bottom of the test page. The test pattern for the color ink cartridge looks like this:

A broken line means a nozzle on the print head needs to be cleaned. A missing color means you need to replace the ink cartridge.

The test pattern for the black ink cartridge looks like this:

If you see a broken line, one or more nozzles may be clogged. See the section “Cleaning the Print Head” in Chapter 5.

What's next?

You're now ready to start using your printer.

- If you want to share the printer with others on your network, see “Using ColorShare to Share Your Printer With Other Users” and “Printing on a Shared Color StyleWriter 1500” in Chapter 2. If you purchased the optional EtherTalk Adapter for this printer, see “Connecting a Color StyleWriter 1500 to an EtherTalk Network” in Chapter 2.
- If you have installed QuickDraw GX and turned it on, see Appendix E.
This chapter explains how to use the Color StyleWriter 1500 for everyday tasks. Before you follow the instructions in this chapter, make sure the printer is set up and working, as described in Chapter 1.

Note: If you use QuickDraw GX, not all of the instructions in this chapter will apply to your software. See Appendix E for more information.

Planning documents with the Color StyleWriter 1500 in mind

Many printer options affect how much can fit on a page. Before you spend a lot of time laying out a document, set it up as you plan to print it:

1. Select the printer you plan to use.
   
   See “Switching Between Printers,” later in this chapter.

2. With the document active on your computer screen, choose Page Setup from the File menu and select the options you like.

   The key areas that affect page layout are paper size, orientation, and scaling percentage. When you’re finished setting your options, click the OK button to return to your document. You can now format it as you like. Since you’ve already set your printing options, the document will print as you see it on your screen.
Loading the sheet feeder

The sheet feeder holds paper, envelopes, or other materials and feeds them automatically into the printer. To load the sheet feeder, follow these steps:

1. Remove any paper or other materials that you don't want to use.
2. Adjust the external paper selector, as shown in the next step.
   It's important to adjust the selector before loading the new material into the sheet feeder.
3. Load the paper or other materials.

**IMPORTANT** Don't mix envelopes with paper in the feeder.

- Insert letterhead paper face up with the top of the page pointing downward.
- Extend this paper support. Make sure the paper extends above the support (and doesn't slide down inside the printer).
- Slide this guide so it just touches the edge of the paper. If the stack of paper bows out even slightly, the guide is too tight.
- Insert envelopes this way. (Make sure the flap is smoothed flat.)
- Insert three-hole punched paper so that the holes line up along this side.
- Make sure the paper lines up evenly at this side of the feeder.
- Don't stack paper above this line (2>).
- Before inserting the material, move the paper selector lever to the envelope icon (✉) for envelopes and to the paper icon (็ด) for everything else.
4 Open the printer’s front cover.

5 Adjust the internal paper selector and extend the output tray.

The selector has two positions (one for paper, the other for envelopes). In the paper (️) position (to the left), the lever lowers the ink cartridge, bringing it closer for thin materials; in the envelope (✉) position (to the right), the lever raises the cartridge to leave room for thick materials.

For paper, start with the selector in the left position. For envelopes, move the selector to the right.

6 Close the printer cover.

7 Before you print, make sure that you set the software options to indicate the size and kind of material you’re using.

- In the Page Setup dialog box, indicate the size of the page.
- In the Print dialog box, indicate the paper type.
Here are details about the kinds of material you can use in the Color StyleWriter 1500 printer.

<table>
<thead>
<tr>
<th>Print material</th>
<th>Maximum</th>
<th>Special instructions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plain paper</td>
<td>100 sheets</td>
<td>• Use 16- to 24-pound paper.</td>
</tr>
<tr>
<td>Premium coated paper</td>
<td>50 sheets</td>
<td>• Use only paper designed for StyleWriter printers.</td>
</tr>
<tr>
<td>Glossy paper</td>
<td>20 sheets</td>
<td>• Use only paper designed for StyleWriter printers.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• The white side should face you.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• To prevent misfeeds, put one sheet of plain paper at the back of the stack.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• The shinier side should face you.</td>
</tr>
<tr>
<td>Transparencies</td>
<td>20</td>
<td>• Use only transparencies designed for StyleWriter printers.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• The shiny side should face you.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• The edge where the paper and transparency are joined should point downward.</td>
</tr>
<tr>
<td>Back-print film</td>
<td>20 sheets</td>
<td>• Use only film designed for StyleWriter printers.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• To prevent misfeeds, put one sheet of plain paper at the back of the stack.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• The chalky side should face you.</td>
</tr>
<tr>
<td>Envelopes</td>
<td>15</td>
<td>• Make sure the envelope flap is smoothed flat.</td>
</tr>
<tr>
<td>Labels</td>
<td>20 sheets</td>
<td>• To prevent misfeeds, put one sheet of plain paper at the back of the stack.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• The labels should face you.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• In the Print dialog box, specify Plain as the paper type.</td>
</tr>
</tbody>
</table>

The Color StyleWriter 1500 supports only the following sizes of materials: U.S. Letter, U.S. Legal, A4 Letter, Executive, #6 envelopes, and #10 envelopes. Don't attempt to use other size materials, or printing errors may result.

For more information about the kinds of material you can use with the Color StyleWriter 1500, see Chapter 3, "Tips on Paper, Quality, Speed, and Cost."
Notes about envelopes

See the instructions that came with the programs you use to see if they offer special, easy ways to format and print envelopes. If not, choose the envelope size you're using in the Page Setup dialog box and format the envelope text as you like.

Printing a document

The next three sections explain the different ways you can print a document:

- **Quick instructions for printing standard documents.** To print documents that don't require any special options, see this section. (The section describes what a "standard document" is.)
- **Detailed instructions for printing other documents.** To print documents that require any of the non-standard options, see this section.
- **Desktop printing.** To print documents without leaving the Finder desktop, see this section. Desktop printing allows you to quickly send multiple documents to multiple printers.

Quick instructions for printing standard documents

Follow the instructions in this section to print a standard document:

- standard paper size (8.5" by 11" in the United States)
- plain paper
- portrait page orientation (so when you look at the printed page, it is longer than it is wide)
- no special effects and normal print quality

Assuming you already selected the printer in the Chooser as described in Chapter 1, and that the printer is filled with standard paper, you need only follow these steps:

1. While the document is in an active window, choose the Print command from the File menu.

The Print dialog box opens on your screen.
2 Click the Print button.

After a few moments, the document starts to print. If the printer is off, it automatically turns itself on. If background printing is turned on, you can continue working while the document is printing. You can also monitor and control the documents that are waiting to print. (See “Printing While You Use Your Computer” and “Monitoring and Controlling Background Printing,” later in this chapter.)

**Detailed instructions for printing other documents**

If your document is not standard (as defined in the previous section), follow these steps:

1 If you haven’t already selected the Color StyleWriter 1500 in the Chooser, do so now.

You already selected the Color StyleWriter 1500 in Chapter 1, and if it's the only printer you ever use, you won't need to do it again. If you do need to switch, see “Switching Between Printers,” later in this chapter.

2 Load the paper, envelopes, or other materials into the printer, as described in “Loading the Sheet Feeder,” earlier in this chapter.

Remember to adjust the external paper selector before filling the sheet feeder.
3 While the document is active on your screen, choose Page Setup from the File menu and make adjustments in the dialog box that opens.

If the default settings shown here are satisfactory, you can skip this step.

Look here to see the effects of the options you choose.

<table>
<thead>
<tr>
<th>Item in dialog box</th>
<th>What you use it for</th>
</tr>
</thead>
<tbody>
<tr>
<td>Page Size</td>
<td>Indicate size of paper in the sheet feeder.</td>
</tr>
<tr>
<td>Layout</td>
<td>Print 2 or 4 mini pages per sheet of paper.</td>
</tr>
<tr>
<td>Borders</td>
<td>Put a border around the mini pages.</td>
</tr>
<tr>
<td>Scaling</td>
<td>Enlarge or reduce the printed image. Type a number between 5 and 999 or choose a number from the pop-up menu.</td>
</tr>
<tr>
<td>Orientation</td>
<td>Indicate whether the printed page should be longer than wide or vice versa.</td>
</tr>
<tr>
<td>Watermark</td>
<td>Specify a background image to be printed on every page.</td>
</tr>
</tbody>
</table>

For more information about the layout, borders, scaling, and watermark features, see “Creating Special Effects on the Color StyleWriter 1500,” later in this chapter.

IMPORTANT Make sure you correctly indicate the size of the paper, envelopes, or other material you installed in the sheet feeder. Additionally, if you change the page size, scaling, or orientation in this dialog box, you might want to look over your document to see if any of the page breaks have changed.
Choose Print from the File menu and make adjustments in the dialog box that opens.

Set the options, then click Print.

<table>
<thead>
<tr>
<th>Item in dialog box</th>
<th>What you use it for</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copies</td>
<td>Type how many copies of the document you want.</td>
</tr>
<tr>
<td>Pages</td>
<td>Indicate how many pages of the document to print. To print the whole document, click All. To print a range of pages, type the beginning and end page numbers. As a shortcut, you can indicate the first page by leaving the &quot;From&quot; box blank or the last page by leaving the &quot;To&quot; box blank.</td>
</tr>
<tr>
<td>Print Quality</td>
<td>Select which level of quality you want. Generally, the higher the quality, the longer the document will take to print. If you use any paper type other than Plain, the Best option is the only one available.</td>
</tr>
<tr>
<td>Paper Type</td>
<td>Indicate what type of material is loaded in the sheet feeder by selecting a choice from the pop-up menu. For labels and envelopes, choose Plain.</td>
</tr>
<tr>
<td>Image</td>
<td>Indicate whether you want the document to print: in color, grays, or black and white. (For black and white or grayscale printing, use the black ink cartridge.)</td>
</tr>
<tr>
<td>Notification</td>
<td>Choose how (if at all) to be notified when the document is finished printing. For a visual alert, choose Message from the pop-up menu. For an audio alert, choose a sound.</td>
</tr>
<tr>
<td>Color</td>
<td>Open another dialog box, in which you can adjust color options, as explained in “Adjusting Color Options,” later in this chapter.</td>
</tr>
<tr>
<td>Utilities</td>
<td>Open another dialog box, in which you can set options to clean the print head.</td>
</tr>
</tbody>
</table>

**IMPORTANT** Make sure the Paper Type pop-up menu accurately indicates what you installed in the sheet feeder.
Click the Print button.

After a few moments, the document starts to print. If the printer is off, it automatically turns itself on. If background printing is turned on, you can continue working while the document is printing. You can also monitor and control the documents that are waiting to print. (See “Printing While You Use Your Computer” and “Monitoring and Controlling Background Printing,” later in this chapter.)

**Desktop printing**

You can also print documents without leaving the Finder, using one of the two methods described here. These methods are particularly efficient when you have a number of documents you want to print at once.

- Drag the icons of the documents you want to print to the desktop icon of the printer you want to use.

![Diagram: Dragging icons to printer]

My Document  Color StyleWriter 1500

*or*

- Select the icons of the documents you want to print and choose the Print command from the File menu. The documents will be printed on the default printer. (See “Switching Between Printers,” later in this chapter.)

In either case, the computer will show you the Print dialog box so you can choose printing options. Make your choices, then click the Print button.

If the printer is off, it automatically turns itself on, and after a few moments, the document starts to print. If background printing is turned on, you can continue working while the document is printing. You can also monitor and control the documents that are waiting to print. (See “Printing While You Use Your Computer” and “Monitoring and Controlling Background Printing,” later in this chapter.)
Adjusting color options

To adjust the way colors are printed, follow these steps:

1. Choose Print from the File menu.
2. In the dialog box that appears, click Color.

Some programs provide a checkbox you must click in order to print in color. See the Read Me file for information about printing in color with specific programs.

3. Select your color options.

The printer blends the ink colors in either a repeating pattern of dots or a random scattering of dots. Many people prefer the look of the Scatter option. Choose the halftoning method you prefer.

The ColorSync color-matching system makes sure that colors look as consistent as possible no matter what device you use to view them—monitor or printer. In addition, ColorSync helps give you the best possible colors when you export the image to another Macintosh computer with ColorSync installed or print it on another color printer.

For more information on ColorSync, see Appendix D.

Note: The 13" monitor uses the default system profile. If you are using a different monitor, you should open the ColorSync control panel and select the correct system profile for your monitor or PowerBook display.
With ColorSync turned on and the Automatic matching method selected, the Macintosh chooses the best matching method for the contents of the document you are printing. If you are not satisfied with the results, you can choose the option you want from the Matching Method pop-up menu. Most of the time, however, the Automatic setting is best.

If you have obtained additional printer profiles from other software companies, you can use the Printer Profile pop-up menu to choose the one you want. (The additional profiles should come with instructions telling you how to choose the appropriate one.)

4 When you've made your choices, click OK to return to the Print dialog box.
5 Click Print.
6 To save the ColorSync settings with this document, choose Save from the File menu.

**Color printing quirks**

Here is some additional information about color printing.

- Different programs may define colors in different ways. When you choose a red in one program, you may not be able to find an exact match in another program. You can adjust the color in the second program until you're satisfied with the printed results. To see how different programs define color, consult the manuals that came with your programs.

- Printing with the color cartridge generally takes longer than printing with the black cartridge. Use the color cartridge only when you want to print in color.
Creating special effects on the Color StyleWriter 1500

You can create a number of special effects on the Color StyleWriter 1500 by selecting options in the Page Setup, Print, and Print Options dialog boxes.

Enlarging or reducing the printed image

You can enlarge or reduce the image on the Color StyleWriter 1500, much as you can on many photocopying machines. Reducing the printed image by a small amount is a popular way to fit a little extra onto each page.

1. Choose Page Setup from the File menu.
2. Enter a scaling percentage.

You can type a number from 5 to 999 or use the pop-up menu. Numbers smaller than 100 reduce the image; numbers greater than 100 enlarge it.

*Note:* Changing the scaling may also change the pagination of your document.

Printing a watermark on each page of your document

Traditionally, a watermark is a translucent image impressed on a piece of paper that you can see only by holding the paper up to the light. The Color StyleWriter 1500 can't do that, but it can put an image on each page of your document, creating the illusion of a watermark. The Color StyleWriter 1500 comes with a number of watermarks already installed, and you can create more, as described in the next section.

1. With your document on the screen, choose Page Setup from the File menu.
2. In the Page Setup dialog box, click the Watermark button.

Another dialog box opens.
Choose the watermark you want from the pop-up menu.

Adjust the Density and Scaling.

When the density slider is all the way to the right, the watermark will print as dark as it is in the original watermark file.

Note the different effects of the scaling options:

- **Centered** scales the image the same amount in both the horizontal and vertical directions, then centers it on the page.

- **Align Top Left** places the image at the upper-left corner of the page without scaling the image at all.

- **Stretch to Fit** scales the image so it fills the page, even if it has to scale the horizontal and vertical directions by different amounts. This may cause the image to be somewhat distorted.

Click OK to return to the Page Setup dialog box.

The settings you choose are remembered by this document, but don't affect other documents.
Creating your own watermarks

You can use any program that can save PICT or PICT2 format files to create your own watermarks. For example, you can create a watermark with your company's logo on it.

1. Create the file with a drawing program or any program that can save PICT or PICT2 files.

Here are some tips for making effective watermarks:

- Make the watermark black. When you print a document with this watermark, you can use the Density control to make it lighter.
- As you draw the image, keep in mind how the watermark scaling options affect the placement of the image when it is printed.

![Watermark file](image1)

- The printing software determines the placement of the watermark based on where it calculates the upper-left and lower-right corners of the image are. If you want to have more control over the placement, you can use your drawing program to place a dot above and to the left of the image in the watermark file to define a new upper-left corner. If you don't want the dot to be visible in your printed document, make the dot white.

![Watermark file](image2)
Save the PICT file inside the PrintingPrefs folder.

To find the PrintingPrefs folder, open the System Folder on your hard disk, then open the Preferences folder. The name you save it as will be the same name that appears in the Watermark dialog box.

**Printing 2 or 4 mini pages on each sheet of paper**

One of the most popular reasons to print mini pages is to save paper when printing long drafts or to make a compact printout of a reference document, such as an address book.

1. With your document on the screen, choose the Page Setup command from the File menu.

2. Choose how many pages you want to appear on each sheet of paper from the Layout pop-up menu.

3. If you’d like a border around each mini page, click to put an X in the Borders box.
Selecting a halftoning method

Halftoning is a process in which colors are blended by using an arrangement of different-colored dots. The Color StyleWriter 1500 blends colors by using either a repeating pattern or a random scattering of dots. The random method generally produces a smoother appearance, though it takes longer to print. The default choice is random scattering.

To change the halftoning method, follow these steps:

1. When you are ready to print, choose Print from the File menu.
   The Print dialog box opens.
2. Click the Options button to open another dialog box.
3. Click Pattern or Scatter.
4. To return to the Print dialog box, click OK.

Switching between printers

If you have more than one printer available, you must select which printer you want to use. The printer you select is called the default printer.

- A bold outline around the desktop printer icon indicates that this is the default printer, where all your documents will print until you indicate otherwise.
- A plain outline around the desktop printer icon indicates that this is not the default printer.

To change the default printer, use one of these three methods, as described in the next sections.

- Drag the document you want to print to a desktop printer icon.
- Select the printer using its desktop printer icon.
- Select the printer using the Chooser.

Note: Switching between printers may change how much information you can fit on a page. It's best to choose a printer before you spend much time paginating the document.
Drag the document you want to print to a desktop printer icon

You can switch to a new default printer by dragging the icon of any document you want to print to the icon of the printer you want to use. (See “Desktop Printing” in the section “Printing a Document” earlier in this chapter.)

Select the printer using its desktop printer icon

If you already have a desktop printer icon for the printer you want to use, follow these steps to select a new default printer without immediately printing anything on it:

1. **Click the icon of the desktop printer you want to use.**
   A Printing menu appears on the menu bar at the top of the screen.

2. **Choose the Set Default Printer command from the Printing menu.**
   Until you choose another printer, the Print command will send your documents to this printer.

Select the printer using the Chooser

If you don't have a desktop printer icon for the printer you want to use, you must select the printer using the Chooser. The Chooser will then create a desktop printer icon for the printer that you select and make it the default printer.

1. **Select the Chooser from the Apple menu.**
2. **Select the printer that you want.**
3. **Close the Chooser by selecting Close from the File menu.**
   When you close the Chooser, it creates a desktop printer icon for the printer you selected.
Creating, throwing away, and manipulating desktop printer icons

To create a desktop printer, select the printer using the Chooser. After you close the Chooser, the icon will appear on your desktop. See “Select the Printer Using the Chooser,” in the section “Switching Between Printers,” earlier in this chapter.

You may also do the following with desktop printer icons:

- **Throw away the icon.** Drag the icon to the Trash. You can't throw away a desktop printer icon while the printer is printing a document. (You can create another desktop printer icon for that printer whenever you like.)
  
  *Note:* You must always have at least one printer icon on your desktop. If you throw away the last icon, it will immediately be created again.

- **Rename the icon.** Rename the icon as you would any other Finder icon. Click the name to highlight it, then type the new name. This changes the name of the icon, not the name of the printer.

- **Move the icon.** You may drag the icon anywhere you like on the desktop. However, you may not move it off the desktop.

- **Create an alias for the icon.** You may create an alias for the icon as you would any Finder icon by selecting the icon and choosing the Make Alias command from the File menu. The alias may be moved anywhere on or off the desktop.

Determining the status of a printer by looking at its icon

You can tell the status of a printer by looking at its desktop icon:

- **Plain icon** indicates a printer that is not currently chosen for printing.

- **Stopped icon** indicates you have stopped the print queue.

- **Default icon** indicates the printer you have currently chosen to print on.

- **Error icon** indicates there is an error on this printer. Double-click the icon to see a message.

- **Printing icon** indicates a document is printing on this printer.

- **Disabled icon** indicates this desktop printer is not available. See Chapter 5.
Printing while you use your computer

You can continue to work on your computer while printing on the Color StyleWriter 1500. The feature that gives you this ability is called background printing, and is automatically turned on when you install the Color StyleWriter 1500 software.

To turn background printing on or off, follow these steps:

1. **Select Chooser from the Apple () menu.**

   The Chooser opens.

2. **Click the Color StyleWriter 1500 icon in the Chooser.**

3. **Click to turn background printing on or off.**

   Once background printing is turned on, it is in effect whenever you print, until you turn it off. When you click Print in the Print dialog box, a message appears for a moment to tell you the document is being prepared. Once the message disappears, you can continue other work. Your computer may pause occasionally while it processes the document for printing. See “Monitoring and Controlling Background Printing,” next, for more information.
Monitoring and controlling background printing

If you are using background printing, you can use the desktop printer features to monitor and control the documents that are waiting to print. To learn how to turn background printing on and off, see “Printing While You Use Your Computer,” earlier in this chapter.

To monitor or control a print request, follow these steps:

1. **Double-click the desktop printer icon you’re interested in.**

   ![Color StyleWriter 1500](Image)

   Color StyleWriter 1500

   A window opens listing the documents that are printing or waiting to print:

   ![Documents in Queue](Image)

   Column titles (click to sort)

   Documents currently printing

   Documents waiting to print

   **About print requests to shared printers**: If you use ColorShare to print a document on a printer that is *not* directly connected to your computer, your print request will be visible in this window for only a few moments. Then the print request moves to the desktop printer on the computer that is directly connected to the printer.

2. **Decide what you’d like to do.**

   - To delete a print request, select its title or icon (by clicking it), then click the Remove button. (You can select more than one item at a time by holding down the Shift key while clicking.) You can also drag the icon for the print request to the Trash. Note that these methods delete only the print request, not the document itself.
To put a print request on hold, select its title or icon (by clicking it), then click the Hold button. The print request will stay on hold until you select its title again and click the Resume button. You can also put the document that's currently printing on hold by dragging it to the list of documents waiting to print.

To indicate that a print request is urgent, select its title or icon (by clicking it), then choose Set Print Time from the Printing menu. In the dialog box that opens, click Urgent. This moves the print request to the top of your list.

To indicate that a print request should not print until a future time, select its title or icon (by clicking it), then choose Set Print Time from the Printing menu. In the dialog box that opens, click At Time, then set the time you want.

To change the order of the items waiting to print, move their place in the list by dragging their titles.

To sort the list of documents waiting to print, click the title of the column you want to sort by. For example, to sort by the name of the document, click Document Name. (You can also sort by choosing the commands in the View menu.) The column title you sorted by is underlined. Sorting the items does not change the order in which they will print. To see that order, sort by Print Time.

To temporarily stop all documents from printing on this printer, choose Stop Print Queue from the Printing menu. To resume using the printer, choose Start Print Queue from the Printing menu. If you're using a PowerBook, this can be a good way to save print requests while you're on the road until you get back to your printer.

Shortcut: The commands to start and stop the print queue are available without opening the window for the printer, so long as the printer's icon is selected on the desktop.

To move a print request from one printer to another printer of the same type, drag the icon for the print request to the icon of the printer where you want to move it. If you're not sure whether the two printers are the same type, try moving the print request anyway—the printer software won't let you move a print request to an incompatible printer.
Using ColorShare to share your printer with other users

If your computer is connected to other computers over an AppleTalk network, you can allow other users on the network to print on your Color StyleWriter 1500. The technology that lets you do this is called ColorShare.

Note the following points about ColorShare:

- Even though you are sharing the printer over a network, the printer must still be connected directly to a single computer using the provided cable, as described in “Connecting the Printer to Your Macintosh” in Chapter 1.

- For others to be able to use the shared Color StyleWriter 1500 printer, your Macintosh must be turned on.

- When other users print on a printer connected to your Macintosh, you may notice that your computer pauses occasionally while you work. Because the printer is attached to your Macintosh, you can see what's being printed by opening the desktop printer icons, as described in “Monitoring and Controlling Background Printing,” earlier in this chapter.

- These instructions work only if you do not use QuickDraw GX software, and only others who do not have QuickDraw GX can share the printer. (QuickDraw GX users can share the printer only with other QuickDraw GX users. They share the printer by clicking its icon, then choosing Sharing from the File menu.)
To share the printer with other non-QuickDraw GX users, follow these steps:

1. Select Chooser from the Apple () menu.

2. In the Chooser dialog box, do the following:

   First, click this icon. (If you don’t see the icon, use the scroll bar and arrows to find it.)

   Then click Setup.

3. In the Sharing Setup dialog box, make the changes you want.

   To share your printer, click to place an X in this box.

   To make your printer available only to people you choose, type a password here.

   Type a name for your printer here. (To avoid confusion, give it a unique name.)

   To use your printer, others must type the password exactly as you have, so remember how you typed the word, including where you used uppercase and lowercase letters or spaces before or after the word.

   Name: Jen's Printer
   Password: [Blank]
   □ Keep Log of Printer Usage

The name you give the printer is the name others will use to select the printer in the Chooser.
4 To keep a record of what's printed on your printer, click the "Keep Log of Printer Usage" checkbox to put an X in it.

You can open and print the log with SimpleText, TeachText, or another word-processing program. To find the log file, open your System Folder; then open the Preferences folder, and open the Printing Prefs folder. The file is called Color StyleWriter 1500 Log.

Note: You can keep a log even if your printer is not shared.

5 Click OK to close the Sharing Setup dialog box.

Sharing works only if background printing is turned on. If it is not turned on, ColorShare turns it on.

6 Close the Chooser (click the close box in the upper-left corner).

If the Color StyleWriter 1500 software has been installed on their Macintosh computers, other users connected to the network can now use your Color StyleWriter 1500, as described in the next section.
Printing on a shared Color StyleWrite 1500

After you turn on ColorShare (as described in the previous section), others on your network can share your printer.

IMPORTANT People on the network who want to print on your shared printer must install the Color StyleWrite 1500 software on their computers, as described in Chapter 1. Older StyleWrite software doesn't work with the Color StyleWrite 1500. After the new software is installed, network users must follow these steps:

1. Select Chooser from the Apple ( ) menu.

The Chooser opens.

2. Make selections in the Chooser.

First, click this icon. (If necessary, use the scroll bar and arrows to find the icon.)

Second, if the network has zones, click one to select it.

Third, click the name of the printer you want to use. If the printer requires a password, a dialog box appears asking you to type it.

3. Close the Chooser (click the close box in the upper-left corner).

After you close the Chooser, a desktop printer icon for the Color StyleWrite 1500 appears.

Anyone who completes these steps can print on the shared Color StyleWrite 1500.

When you print a document to a shared Color StyleWrite, your computer transfers the request to the computer directly connected to the printer. As soon as the transfer is complete, your computer thinks the document has finished printing. You can continue monitoring the print request on the computer that is directly connected to the printer.
Connecting a Color StyleWriter 1500 to an EtherTalk network

If you have the optional StyleWriter EtherTalk Adapter, you can connect a Color StyleWriter 1500 printer directly to an EtherTalk network.

To attach the EtherTalk Adapter and connect your Color StyleWriter 1500 to the network, follow the instructions that come with the adapter. Once the printer is on the network, its name appears in the Chooser just like the names of other network printers.

If you want to change the name, click Rename. In the dialog box that appears, type a new name for the Color StyleWriter 1500 printer. (Note: Anyone on the network can change the name.)
This chapter explains how to use different print materials and software options to meet your needs.

Choosing print materials

Here are some tips on when and how to use different print materials.

Plain paper

Use plain paper for everyday printing.

- Print quality may vary depending on the manufacturer of the paper. If you're not happy with one kind of paper, try a different brand. You can also use one of the special papers designed for StyleWriter printers.
- You can use any plain paper, including plain copier paper. Paper weight can range from 16 to 24 pounds. Bond paper works well.
- Don't use erasable typing paper, damaged or wrinkled paper, stapled paper, or multipart forms (“carbonless carbons”).
- Plain paper almost always has one side that is better for printing than the other. See the package label to determine which side is better, and load that side so that it faces you.
Premium coated paper

- Use only coated paper designed for use with StyleWriter printers.
- One side of the paper is a little whiter than the other and is better for printing. See the package label on the coated paper to determine which side is better, and load that side so that it faces you.

Glossy paper

- Use only glossy paper designed for use with StyleWriter printers.
- When loading a stack of glossy paper into the sheet feeder, put a single sheet of plain paper at the back of the stack to prevent misfeeding.

Back-print film

Back-print film has a shiny surface and works exceptionally well when displayed by backlighting.

- Use only back-print film designed for use with StyleWriter printers.
- Load back-print film so that the chalky side faces you.
- When loading a stack of back-print film into the sheet feeder, put a single sheet of plain paper at the back of the stack to prevent misfeeding.
- In the Print dialog box, be sure to select Back Print as the paper type.
- The printer automatically reverses the image and prints it on the film's chalky side so that the image looks correct when viewed from the shiny side.

Transparencies

Use transparencies when you want to present your document on an overhead projector.

- Use only transparencies designed for use with the Color StyleWriter 1500. These special transparencies have a sheet of paper attached to them; leave the paper attached until after printing Transparencies designed for laser printers or copiers work very poorly on the Color StyleWriter 1500.
- Load the transparencies so that the shiny side faces you and the edge where the paper and the transparencies are attached points downward.
Quality

For highest-quality printing, choose Best quality and print on coated or glossy paper, back-print film, or transparencies.

Select Best quality. Best quality takes longer to print, but you get better quality—even on plain paper.

Color StyleWriter 1500

Select Best quality. Best quality takes longer to print, but you get better quality—even on plain paper.

Also use the following selections in the Color Options dialog box. (To display the dialog box, click the Color button in the Print dialog box.)

To turn on color matching and get the best-quality color printing, click to put an X in the ColorSync check box.

Many people prefer the look of the Scatter halftoning method.

For more information on color matching, see “Adjusting Color Options” in Chapter 2.
Speed

For faster printing, change the Print Quality setting in the Print dialog box. (To display the dialog box, choose Print from the File menu.)

![Print Quality Settings](image)

Printing with the color cartridge takes longer than printing with the black cartridge.

The black ink cartridge is designed for efficient, high-speed, black and grayscale printing.

Cost

To reduce the amount of ink you use, select Draft quality in the Print dialog box whenever possible.

Don't unplug the printer unnecessarily or connect it to a power strip that you turn off occasionally. When you reconnect the power, it uses ink as it cleans the print head.

To print black and white pages most cost-effectively, use the black cartridge instead of the color cartridge.
Maintaining Your Printer

It doesn't take much effort to keep your Color StyleWriter 1500 printer in
good working condition. You simply have to replace the ink cartridge when it
runs out of ink and clean the printer or print head if you notice a problem.

For other service, see the information about service and support that comes
with your Color StyleWriter 1500.

IMPORTANT Follow all the safety instructions given at the beginning of
Chapter 1.
Replacing an ink cartridge

The ink cartridge contains the print head, the device that takes the ink and sprays it on the paper. The black ink cartridge has enough ink to print about 500 pages at 5% coverage—when ink covers 5% of the page. (A typical double-spaced page has about 5% coverage.) A color ink cartridge has enough ink to print about 100 pages at 30% coverage, using equal amounts of each color.

When to replace the color cartridge

When only one color runs out, you may notice a color shift. To determine whether one color is not printing at all, try printing the test page. See “Checking the Print Nozzles” in Chapter 1.

When to replace the black ink cartridge

Knowing when to replace the black ink cartridge is fairly simple. When it runs out of ink, it stops printing.

Note: If you see other problems with print quality, such as unwanted white lines in a document, see “Cleaning the Print Head,” in the section “Unwanted Horizontal White Lines or Stripes Appear,” in Chapter 5.)

How to find ink cartridges

You should be able to find cartridges and other supplies for your Color StyleWriter 1500 printer at any Apple-authorized reseller.
Storing the ink cartridge you aren't using

The Color StyleWriter 1500 comes with two ink cartridges, a color cartridge and a black cartridge. While they are sealed in their original packaging, the ink cartridges are protected. If you open both packages and switch ink cartridges for printing different documents, be sure to store the one you're not using in the storage case supplied with your Color StyleWriter 1500. The storage case keeps the print head from drying out and prevents accidents with ink stains.

Be careful not to touch this area on the ink cartridge, or you may stain your fingers with ink.

Once you've removed both cartridges from their original packages, always keep one inside the printer and the other in the storage case.
How to replace the ink cartridge

1. Open the printer's cover.

2. Raise the bright blue lever on the carrier and remove the cartridge.
   Dispose of the cartridge.
   **IMPORTANT** Be careful not to touch the print head, or you may temporarily stain your fingers with ink.

3. Install the new ink cartridge as described in "Installing the Ink Cartridge" in Chapter 1.
   If you try to install the new cartridge without looking at the instructions in Chapter 1, remember these commonly overlooked steps:
   - Remove the bright orange cap from the cartridge's print head.
   - Peel the orange tape off the print head.
   - Do not touch the print nozzles, which are covered by the orange cap.
Cleaning the outside of the printer

Before you clean the printer, turn it off and unplug the power cord. Then wipe the outside of the printer with a clean, soft cloth dampened with water. If necessary, you can use a mild soap or detergent. Be careful not to get any liquid in the power cord receptacle.

**WARNING** Don't use ammonia-based or alcohol-based cleaners on or around the printer—they may react with the plastic.

Cleaning the inside of the printer

Occasionally you may need to wipe off paper dust or drops of ink inside the printer. Turn the printer off and unplug it. Then open the printer and carefully clean the rollers and platen with a soft, dry cloth.

If necessary, you can clean the rollers and platen with a soft, dry cloth.

**WARNING** Don't use any liquid cleaners inside the printer.
This chapter provides solutions to some problems that you may encounter while using your Color StyleWriter 1500 printer.

As long as you follow the maintenance instructions in Chapter 4, you're not likely to have any problems with your Color StyleWriter 1500. The most common source of trouble is faulty software installation. To avoid these problems, follow the software installation instructions in Chapter 1.

**WARNING** If you have a problem with your Color StyleWriter 1500 printer and nothing presented in this chapter solves it, consult the service and support information that came with your printer for instructions on how to contact an Apple-authorized service provider or Apple for assistance. If you attempt to repair the Color StyleWriter 1500 yourself, any damage you may cause to the printer will not be covered by the limited warranty on your printer. Contact an Apple-authorized dealer or service provider for additional information about this or any other warranty question.
Safety precautions

To prevent damage to the Color StyleWriter 1500 printer, and harm to yourself and other users, follow these safety tips.

- Don't touch anything inside the printer except as described in the instructions in this manual. Otherwise, you may damage delicate mechanical parts.
- Don't shake the ink cartridges. Ink can leak out and cause stains.
- Don't oil the inside of the printer.
- Don't attempt to disassemble the printer.
- Before you unplug the printer, make sure it is turned off. (The green power light should be off.) Turning the power off ensures that the carrier has returned securely to its home position and the cartridge has been capped.

The Chooser doesn't show the Color StyleWriter 1500 icon

If you open the Chooser and don't see the Color StyleWriter 1500 icon, you probably need to install the appropriate printer software. For instructions, see “Installing Your Printer Software” in Chapter 1.

Installation is unsuccessful

If a message tells you that installation was not successful—or if you have to repeatedly swap between the same two disks—check to make sure you restarted your computer with all your software extensions off as explained in Chapter 1. If that doesn't work, try removing corrupted fonts or performing a custom installation, as described in the next two sections.
Removing items from your Fonts folder to solve installation problems

Items in your current Fonts folder can interfere with successful installation of the printer software. To correct the problem, follow these steps:

1. Quit all programs you are currently running.

2. Open the Fonts folder (inside the System Folder) on your Macintosh.

3. Drag the following files out of the Fonts folder. (Look for files with exactly these names.)
   - Avant Garde
   - Bookman
   - Delphian
   - Garamond Narrow
   - Helvetica Black and Helvetica Compressed
   - Lubalin Graph
   - Lucida Bright
   - Machine
   - N Helvetica Narrow
   - Nadianne
   - New Century Schlbk
   - Old English Text
   - Onyx
   - Oxford
   - Swing
   - Zapf Chancery
   - Zapf Dingbats
   - Zeal

   You can put the fonts temporarily into a new folder and drag the folder to your desktop. Then, after you install the Color StyleWriter 1500 software (including these fonts), you can drag the temporary folder to the Trash.

4. Repeat the software installation procedure in Chapter 1.

For more details about fonts, see Appendix B.
Using the Custom Installer to solve installation problems

You can install the printer software without installing the fonts that come with the printer. (The disadvantage is that you won't be able to use these fonts if you don't already have them.)

1. Insert the Color StyleWriter 1500 Installation disk into a floppy disk drive.
   If necessary, open the disk icon.

2. To start the Installer program, double-click its icon.

3. In the Welcome dialog box that appears, click Continue.

4. In the Installer dialog box, choose Custom Install.

5. In the Custom Install dialog box, click the QuickDraw Printer Software checkbox.

First, click this checkbox. (An X appears to show it's selected.)

Second, make sure the disk named here is the one on which you want to install the Color StyleWriter 1500 software. (If not, click Switch Disk until the correct name appears.)

Finally, when you're ready to begin, click Install.
6 When you see a message on your screen, follow the directions and insert the next disk.
The Installer ejects disks and asks you to insert others. Keep following the instructions on the screen until the installation is complete.

7 When you see a message reporting that installation was successful, click Restart.
The Installer restarts your Macintosh.

The computer crashes while attempting to print
When a computer suddenly stops working—either a message on the screen tells you a system error occurred or the mouse and keyboard act as if they’re disconnected—the computer has crashed.

If your computer often crashes after you tell it to print a document, your printing software may have become corrupted, Reinstall the printer software by following the instructions in “Installing Your Printer Software” and “Telling Your Computer to Use the Color StyleWriter 1500” in Chapter 1.

A Power Macintosh has trouble printing to the Color StyleWriter 1500
If you are using a Power Macintosh computer, be sure to turn on Virtual Memory before you try to print on the Color StyleWriter 1500. Then choose a setting that’s at least 1 MB higher than your “Available built-in memory” (You can set it higher without any ill effects.) With this setting, you will avoid some potential printing problems. Turning on Virtual Memory also reduces the amount of memory needed by many applications. For instructions on turning on Virtual Memory, see the documentation that came with your computer.

A PowerBook has trouble printing to the Color StyleWriter 1500
Some PowerBook computers have special requirements for printing. See “Special Information for PowerBook Owners” in the section “Telling Your Computer to Use the Color StyleWriter 1500” in Chapter 1.
The Macintosh doesn’t recognize the Color StyleWriter 1500

If you have selected the Color StyleWriter 1500 printer in the Chooser but nothing prints, or you get a message that no Color StyleWriter 1500 is connected, one of the conditions in the list that follows may be the cause.

Note: Before you try to solve the problem, open the Color StyleWriter 1500 desktop printer icon to see if there are any error messages and to check how many print requests are waiting. If you repeatedly tried to print a document, there may be multiple copies waiting to print. You can delete anything you don’t want by selecting its title, then clicking the Remove button. See “Monitoring and Controlling Background Printing” in Chapter 2.

- A plug may be loose. To make sure that all cables are securely connected, turn off the computer and the printer, then unplug each end of each cable you want to test and plug it back in. For connection instructions, see Chapter 1.

- Make sure you use the serial cable that came with the printer to connect it directly to your Macintosh. Do not use a LocalTalk cable or attempt to connect the printer to a LocalTalk network.

- You may have indicated the wrong port in the Chooser. Open the Chooser and change the port selection. (Look at the back of the computer to see whether you plugged the printer into the computer's printer port [ ] or modem port [ ].)

- If you are trying to use a shared printer connected to another Macintosh and the printer name isn’t listed in the Chooser, make sure that the other Macintosh is turned on and connected to the network. Also, make sure that the printer is set up to be shared. Then try again to select the printer in the Chooser. (Note: QuickDraw GX users can share a printer only with other QuickDraw GX users and non-QuickDraw GX users can share only with other non-QuickDraw GX users.) See the instructions in “Using ColorShare to Share Your Printer With Other Users” in Chapter 2.

- You may be using the wrong printer software. Make sure you installed the software as described in Chapter 1 and that you have selected the printer as described in “Telling Your Macintosh to Use the Color StyleWriter 1500,” also in Chapter 1.
• If you're using a PowerBook computer with an internal modem, change the serial port setting to Normal or External. For details, see “Special Information for PowerBook Owners” in the section “Telling Your Computer to Use the Color StyleWriter 1500” in Chapter I.

• If your computer is not connected to a network, turn off AppleTalk in the Chooser.

• The printer may need to be reset. Turn the printer off, count to five, then turn it back on.

If you still can't resolve the problem, the printer may not be working properly. See the information about service and support that comes with your printer.

Desktop printer icons behave unusually

A desktop printer icon appears again as soon as I drag it to the Trash.

You must always have at least one desktop printer icon. If you drag your last desktop printer to the Trash, the computer instantly creates another one just like it.

If you don't want to use desktop printers at all and you have System 7.5 or higher, you can use the Extensions Manager control panel to turn off Desktop PrintMonitor, Desktop Printer Extension, and Desktop Printer Spooler. Or you can use the Installer's Custom Remove feature to remove the desktop printing software, as described in Appendix F.

An X appears over the desktop printer icon.

When a desktop printer is not working, it appears with an X over it.

• You may have started up the computer using a different startup disk or temporarily turned off all the software extensions. When you restart the computer as usual, the icons will return to normal.

• You may have removed the desktop printing software that created the printer icons. If you meant to do so, you can drag the icons to the Trash. If not, you can reinstall the software as explained in Chapter 1.
The power light indicates a problem

Sometimes the power light on the printer signals a problem.

- **The light flashes.** The printer may be out of paper or the paper may have misfed. Check your computer screen for messages. See Chapter 2 for instructions on loading the sheet feeder, or “Paper Is Jammed” and “Paper or Envelopes Feed Improperly,” later in this chapter. Also, if there is no ink cartridge in the printer or the cartridge has not been installed properly, the light flashes. See “Installing the Ink Cartridge” in Chapter 1.

- **The light is off.** To conserve energy, the printer turns itself off if it's left idle for some time (usually about 5 minutes). If you suspect a problem, press the power button. If the light remains off, check to make sure the power cord is plugged in properly and the outlet has power. If you can’t turn the printer light on, see the information about service and support that comes with the printer.

The printer seems slow

See the suggestions in “Speed” in Chapter 3.

If you have a Macintosh IIfx, Macintosh Quadra 900, or Quadra 950 computer, check the Serial Switch control panel. Make sure the setting is “Compatible.”

*Note:* The printer automatically takes a few moments to clean the print head when it is plugged back in or after more than three days of inactivity.
Paper is jammed

Occasionally a piece of paper may get jammed (stuck) inside the printer during the printing process. To clear a paper jam, follow these steps:

1. If necessary, open the printer to see where the jam is.
2. Gently pull the paper free.

More than one piece of paper passes through the printer at a time

Follow these steps:

1. Remove all the paper from the sheet feeder.
2. Turn off the printer.
3. Turn the printer back on.
4. Put the paper back in.
Paper or envelopes feed improperly

If paper tears, gets skewed, or comes through the printer crumpled, it may not be entering the printer properly. Try the following:

- **Make sure you have loaded the paper correctly**, paying special attention to both internal and external paper selector levers. Be sure you adjust the external selector before installing the paper.

  For instructions on loading paper, see “Loading the Sheet Feeder” in Chapter 2.

- **Do not overload the sheet feeder.**
  The feeder holds up to 15 envelopes or up to 100 sheets of 20-pound paper. If you use heavier paper, fewer sheets will fit in the feeder.

- **Do not force paper into the sheet feeder.**

- **Make sure nothing has fallen into the sheet feeder.**
  Remove any paper from the sheet feeder, then carefully turn the whole printer upside down and shake it.

- **Try to remove any torn or damaged pieces of paper from the printer.**

See the section “Paper Is Jammed,” earlier in this chapter.
Take the paper out of the sheet feeder and check it.
Make sure none of the sheets is curled, bent, or dog-eared.
Make sure the edges of the stack line up evenly.
Make sure the left paper guide isn't too snug or too loose. The stack should lie flat (not bowed).
Make sure the paper doesn't slide down into the printer.
Load either envelopes or paper (not both) into the sheet feeder.
Make sure you have inserted envelopes correctly. The flaps should lie flat against the envelope, the edges should be smoothed flat, and no air should be trapped in the envelopes.
When loading back-print film, labels, or glossy paper, put a sheet of plain paper at the back of the stack.
When loading transparencies, the shiny side should face you. The edge where the paper and the transparency are joined should point downward.

The Color StyleWriter 1500 won't print a particular document

If you attempt to print a document and no page is printed—not even a blank one—try the following:

■ Check for messages on your Macintosh screen. Also, open the window for your printer by double-clicking its desktop icon.

■ Your computer may be low on memory. See “Memory is Low” later in this chapter.

■ Turn the printer off, then on again. (This resets the printer.)

■ Repeat the printing process.

Sometimes problems disappear when you try to print your document again.

■ Printing problems can often be caused by errors in your programs. If you can print from the SimpleText or TeachText program but not from another program, it's probably a problem with that program. Contact the publisher of that program for help.

■ Restart your Macintosh.
The printer acts as if it's working, but nothing is printed on the page

If your printer takes the paper, but doesn't actually print anything, try the following:

- If the ink cartridge is new, make sure that you removed the orange plastic cap and orange tape from its print head.
- Make sure the ink cartridge is correctly installed. (For instructions, see “Replacing the Ink Cartridge” in Chapter 4).
- The printer may be out of ink. You can check by seeing whether the test page prints. To print a test page, see “Printing the Test Page” in the section “Print Quality is Poor” later in this chapter.

Messages appear on your computer screen

Most messages that appear on your screen are self-explanatory. For example, they may tell you that the printer is out of paper or that the paper is jammed. Once you correct the problem, the message goes away.

Here are some other problems that on-screen messages might report:

Serial port in use by another application

Restart your computer before trying to print again.

The waste ink container in the printer is full.

From time to time, the printer deposits some ink into a waste container. In the rare event that the container becomes full, Apple recommends that you take the printer to an Apple-authorized service provider.

Your document will be printed in the background when more memory is available.

The computer doesn't have enough spare memory to print in the background.

- Click Cancel if you don't want to print.
- Click Print Later if you want the document to print when more memory is available. To free up memory, quit some of the programs you are running.
- Click Print Now to print the document in the foreground. You won't be able to use the computer until the document is printed.
There is an error in the printer.

Check to make sure the cable is still connected to the printer and the computer. Also, the ink cartridge may not be seated properly. Turn off the printer and open the printer's cover. Make sure the cartridge is inserted properly and that the blue lever on the side of the carrier is firmly lowered to secure the cartridge in place.

The printer detects an end-of-paper error.

If you are using a valid size of paper, make sure that you indicate the size in the Page Setup dialog box. Valid sizes for the Color StyleWriter 1500 are: U.S. Letter, U.S. Legal, A4 Letter, Executive, #6 envelopes, and #10 envelopes. Other sizes will not work correctly.

No Paper or Wrong Paper Size

These messages usually mean what they say. Occasionally they can appear when you have the wrong port indicated in the Chooser. See “Telling Your Computer to Use the Color StyleWriter 1500” and “Special Information for PowerBook Owners” in Chapter 1.

Memory is low.

See the next section.
Memory is low

Once in a while, your computer may be temporarily low on random-access memory (RAM).

**Symptoms that indicate a memory problem.**
- Some documents do not print.
- Some text incorrectly appears in the Geneva font.
- Characters look jagged.
- An “out of memory” message appears on your screen.

**If you have a memory problem, try the following:**
- Run only one program at a time; quit the ones you’re not using.
- If memory has been severely fragmented, you should quit all open applications, then reopen just the one you’re using.
- Choose “Black and White” from the Image pop-up menu in the Print dialog box. Printing in black and white takes the least memory.
- Increase the amount of memory you give to the program you’re printing from by using the Get Info command (as explained in the instructions that came with your Macintosh).
- Turn off background printing. See “Printing While You Use Your Computer” in Chapter 2.
- In the Page Setup dialog box, choose Portrait (normal) orientation instead of Landscape (sideways) orientation.
- Turn on virtual memory in Memory control panel. Virtual memory is described in the instructions that came with your computer. *(Note: Using virtual memory can sometimes slow down your computer)*
- Obtaining additional RAM for your computer can solve some of these problems and improve printing speed.
- When you print in the background, if you often get a message that there is not enough memory to print on a certain desktop printer, you can give that desktop printer more memory by selecting its icon and choosing the Get Info command. Then increase the number in the Preferred Size box. *(For more information on increasing a program’s memory, see the documentation that came with your Macintosh)*
As long as there are any print requests waiting to be printed, Desktop PrintMonitor (the desktop printing software) remains active in memory, even when background printing is off. If you are not printing in the background, you can remove all print requests from your desktop printer queues to reduce memory requirements by 160K.

- Remove desktop printing. See Appendix F.

Documents did not print as expected

If the quality of printing is OK—not smeared or incomplete—but the result is not as you expected, you may have made a mistake in using the printer software. Check the subsections that follow for suggestions.

Text appears in the Geneva font or prints jagged

When your Macintosh computer is low on memory, it may display and print certain fonts in the Geneva font. (Geneva looks like this.) Some text may also have jagged edges. To fix low-memory problems, see “Memory is Low,” earlier in this chapter.

If you're printing to a shared Color StyleWriter that is not directly connected to your computer and you use Adobe Type Manager, the PostScript version of your fonts must be installed on the computer that is directly connected to the Color StyleWriter.

For more information about fonts, see Appendix B, “Using Fonts With the Color StyleWriter 1500 Printer.”

Some rotated text may print jagged if you apply a style that has not been defined for the font. Try applying plain style to the text.
Text prints but pictures do not

Some advanced page layout and art programs use the PostScript page description language, a language that the Color StyleWriter 1500 does not understand. If your programs have a PICT preview option, you can print the file on a Color StyleWriter 1500.

Page breaks change unexpectedly

Most programs determine where to break pages by evaluating the information you provide in the Page Setup dialog box. Also, different types of printers may space text in slightly different ways. The following actions can cause page breaks to change:

- changing from one type of printer to another
- changing the page size in the Page Setup dialog box
- scaling the document in the Page Setup dialog box
- changing the orientation in the Page Setup dialog box

It's best to choose the printer you want and the Page Setup options you need before working on your page breaks.

A page prints off center

This problem may result from one of the following conditions:

- You have selected the wrong page size in the Page Setup dialog box.
- The margins are set incorrectly in the document you are printing.
- Paper is not placed properly in the sheet feeder. See “Paper or Envelopes Feed Improperly,” earlier in this chapter.
- You are not using recommended printing materials.
Text lines up in columns on the screen but not when it prints

You may have used spaces (rather than tabs) to line up the text. Because printers interpret spaces differently than the screen does, the text may fail to line up when you print it. Try replacing the spaces with tabs.

You can also make columns by using a monospace font—such as Courier or Monaco—instead of tabs. A monospace font is one in which every character has the same width.

Everything prints backwards

Choose the Print command and check what paper type you've selected in the dialog box that opens. If you indicate that you're printing on back-print film, the printer reverses the image.

Watermark problems

The wrong watermark printed.

If you selected one watermark, but a different one printed, you can fix it by changing the modification date and time of one of the watermark files. To change the modification date, open one of the files, then save it using the Save As command. (The watermark files are stored in the Printing Prefs folder, which is in the Preferences folder inside the System Folder.) When asked if you want to replace the file, say yes.

I created a new watermark, but it doesn't show up in the dialog box.

- Make sure the watermark was saved as a PICT or PICT2 file.
- Make sure the file was saved in the Printing Prefs folder, which is in the Preferences folder inside the System Folder.
Print quality is poor

Most image problems are caused by problems with an ink cartridge or with your choice of paper. Don't use the following types of paper:

- erasable typing paper
- damaged, wrinkled, or stapled paper
- multipart forms ("carbonless carbons")
- glossy paper, unless it's especially designed for StyleWriter printers

If you use plain paper, use 16- to 24-pound copier paper; 20-pound paper is recommended. Plain papers can vary widely. If you're not happy with one kind of paper, try a different brand.

Colors skip or streak at the bottom of the page

If you're not happy with the quality of printing near the bottom of a page, change the setting for the bottom margin to 0.5 inch or more.

The image is too light or too dark

If printing looks fuzzy because it's too light or too dark, try the following:

- Check the nozzles in the print head. See "Printing the Test Page" later in this chapter for instructions. If this doesn't help, replace the ink cartridge. See "Replacing an Ink Cartridge" in Chapter 4 for instructions.
- Make sure you've chosen the correct paper type in the Print dialog box.
- If you're using plain paper, try flipping the stack of paper in the paper tray. Most paper has one side that's better for printing. If you're using other material, make sure you have it loaded in the correct orientation. See "Loading the Sheet Feeder" in Chapter 2.
- Try using a different kind of paper.
- Try choosing Best quality in the Print dialog box.
Thin lines fade or break up

Pick a darker color for the affected object, or try printing with the Pattern halftoning option selected. (In the Print dialog box, click the Options button, then click the Pattern button.)

Ink smears when rubbed

Don't handle pages before the printer ejects them from the printer and delivers them into the output tray. This allows time for the ink to dry.

Pages leave the printer smeared, blurred, or smudged

The print head may be too close to the paper it's printing on. Move the internal paper selector to the envelope (✉) position. See “Loading the Sheet Feeder” in Chapter 2.

Printing appears on only part of the paper

Check the selections in the Page Setup dialog box. You may have set the page size incorrectly.

Check the nozzles in the print head. See “Cleaning the Print Head,” later in this chapter for instructions. If this doesn't help, replace the ink cartridge. See “Replacing an Ink Cartridge” in Chapter 4 for instructions.
Colors don't look right on the printed page

- Try printing the image with ColorSync turned on. For instructions, see “Adjusting Color Options” in Chapter 2.
- Try using a different type of paper.
- Try printing the test page and evaluate the printed patterns.

Printing the test page

To print the test page, follow these steps:

1. Turn off the printer.
2. Make sure you’ve loaded U.S. letter-size or A4 paper into the printer.
3. Press and hold down the power button for about 5 seconds.
4. Release the power button and wait for the test page to print.
5. Examine the nozzle test pattern for broken or missing diagonal lines.

The nozzle test pattern appears near the bottom of the test page. The test pattern for the color cartridge looks like this:

A broken line means a nozzle on the print head needs to be cleaned. A missing color means you need to replace the ink cartridge.

Yellow
Magenta
Cyan

The test pattern for the black cartridge looks like this:

6. If you see broken or missing lines, try the following:
   - If you see a broken line, clean the print head. (For instructions, see “Cleaning the Print Head” in the next section.)
   - Replace the ink cartridge.
Unwanted horizontal white lines or stripes appear

Problems with print quality, especially horizontal white lines in your document, may mean a nozzle on the print head is clogged or your ink cartridge is running out of ink. To solve the problem, try cleaning the print head as part of a print request. (This tells the printer to clean the print head before it starts printing the next document.)

**IMPORTANT** Cleaning the print head consumes a small amount of ink. If you repeat the procedure unnecessarily, you reduce the life of your cartridge.

Explanations of these two procedures follow.

**Cleaning the print head**

To clean the print head, follow these steps:

1. When you are about to print a document, click Utilities in the Print dialog box.
   
   *Note:* If the printer is being shared by using ColorShare, you must print the document from the computer that is directly connected to the printer.

2. Make your choices in the Utilities dialog box.

   ![Utilities dialog box]

   The Utilities dialog box closes, and the Print dialog box reappears.

3. In the Print dialog box, click Print.

   The printer cleans the print head before printing your document.

   *Note:* After the printer cleans the print head and prints your document, the cleaning option is automatically turned off. You don't have to turn it off before printing again.
The image prints wavy or distorted

Make sure that you are using recommended types of paper. Check the setting of the internal paper selector above the ink cartridge. If the problem persists, see the information about service and support that comes with the printer.

Stains appear on printed pages

Stains on the backs or tops of printed pages may mean that ink has spilled inside the printer. If so, the ink can transfer to the rollers and from there to the paper. Follow the instructions in “Cleaning the Inside of the Printer” in Chapter 4.

Ink cartridges run out of ink too quickly

If it seems like an ink cartridge has run out of ink too quickly, clean the print head to make sure the cartridge is actually out of ink and not just clogged. See “Printing the Test Page,” earlier in this chapter.

To extend the life of your ink cartridges, try the following:

- Select Draft print quality in the Print dialog box whenever you can.
- Don’t clean the print head unless necessary.
- Don’t print solid background colors unless necessary.
- Don’t unplug the printer or otherwise discontinue power frequently.
- Don’t print the test page unless necessary.
- If you print mostly black and white documents, use the black ink cartridge.

The more ink you use per page, the fewer pages you’ll be able to print per ink cartridge. For example, if you print single-spaced text, you get half the number of pages you would get printing double-spaced text.

Pages printed with the color cartridge typically use much more ink per page than pages printed with the black cartridge.
Appendix A
Technical Information

General specifications

Marking engine
- Thermal ink-jet engine

Resolution

The resolution for graphics and text differs according to the quality of printing you select, the type of paper you select, and the cartridge you use. It is expressed in horizontal by vertical dots per inch (dpi).

- Black cartridge
  - Best: 720 x 360 dpi (edge smoothing, black cartridge)
  - 360 x 360 dpi (gray printing).
  - Normal: 360 x 360 dpi
  - Draft: 180 x 180 dpi

- Color cartridge
  - Best: 360 x 360 dpi
  - Normal: 360 x 360 dpi
  - Draft: 180 x 180 dpi

Engine speed

- Printing speed depends on the images you print, the options you select, and on the Macintosh computer you use.
Connector cable

- Apple System/Peripheral-8 cable

Interface

- High-speed serial (RS-422)
- Optional EtherTalk Adapter

Fonts

- TrueType font support
- 64 TrueType fonts available, consisting of the 43 that come with the Color StyleWriter 1500 and the 21 that come with Macintosh system software (see Appendix C for a list of available fonts)
- Adobe PostScript font support when used with Adobe Type Manager software (sold separately by Adobe Systems Incorporated)

Sheet feeder

- Holds up to 100 sheets of 20-pound (75 grams/meter²) paper or 15 envelopes.

Printing materials, weights in pounds (lb.) and grams/meter² (g/m²)

- Plain paper: Use 16-lb. (60-g/m²) to 24-lb. (90-g/m²) paper.
- Accepts most letterhead and colored stock.
- Accepts medium-weight sheets of labels.
- Use #6 or #10 envelopes.
- You can also use glossy and coated paper and back-print film especially designed for StyleWriter printers.
- For fast drying time on overhead transparencies, Apple recommends ink jet transparencies especially designed for StyleWriter printers.
Paper sizes in millimeters (mm) and inches ("")
- U.S. Letter: 215.9 mm x 279.4 mm (8.5" x 11")
- U.S. Legal: 215.9 mm x 355.6 mm (8.5" x 14")
- A4: 210 mm x 297 mm (8.3" x 11.7")
- Executive: 184.15 mm x 266.7 mm (7.25" x 10.5")
- #6 envelopes: 165.1 mm x 92.1 mm (6.5" x 3.625")
- #10 envelopes: 241.3 mm x 104.7 mm (9.5" x 4.125")

Printable area in millimeters (mm) and inches ("")
- Maximum printable line: 203.2 mm (8.0")
- Minimum margins
  - Left and right: 6.35 mm (0.25")
  - Top: 5 mm (0.2")
  - Bottom: 10 mm (0.39")

Printer dimensions in millimeters (mm) and inches ("")
- Height (paper support down): 176 mm (6.9")
- Width: 348 mm (13.7")
- Depth: 215 mm (8.5")

Weight
- Approximately 2.5 kilograms (5.5 pounds)
Operating environment

Temperature
- 15° to 30° C (59° to 86° F)

Relative humidity
- 10 percent to 80 percent, noncondensing

Storage environment

Temperature
- 0° to 35° C (32° to 95° F)

Humidity
- 5 percent to 95 percent, noncondensing

Power consumption

Operating
- 30 watts maximum

Power requirements for AC power adapter

The electrical requirements vary depending on the country for which your model was manufactured

Power supply
- AC power adapter
Apple part numbers

If you have trouble finding any of the following products, the part numbers may help you describe them to the dealer. However, you should note that part numbers sometimes change as products are enhanced.

Ink cartridges

- Color StyleWriter Ink Cartridge: M4609G/A
- StyleWriter Black Ink Cartridge: M8041G/C

Connector cable

- Apple System/Peripheral-8 cable: M0197LL

Printing materials

- Apple Color Ink-Jet Transparency Film, Letter-size: M2658G/A
- Apple Color Ink-Jet Transparency Film, A4-size: M1959G/A
- Apple Color Ink-Jet Premium Coated Paper, Letter-size: M2952G/A
- Apple Color Ink-Jet Premium Coated Paper, A4-size: M2951G/A
- Apple Color Ink-Jet Glossy Paper, Letter-size: M3655G/A
- Apple Color Ink-Jet Glossy Paper, A4-size: M3656G/A
- Apple Color Ink-Jet Back-Print Film, Letter-size: M2953G/A
- Apple Color Ink-Jet Back-Print Film, A4-size: M2954G/A

Available Options

- StyleWriter EtherTalk Adapter
  - North America–style plug: M4775LL
  - Japan-style plug: M4775J
  - Continental Europe–style plug: M4775ZM
  - United Kingdom–style plug: M4775B
  - Australia-style plug: M4775X
Appendix B
Using Fonts With the Color StyleWriter 1500

A font is a collection of letters, numbers, and symbols in a distinctive typographic design. Your Macintosh computer and Color StyleWriter 1500 printer come with a variety of fonts that look great both on your monitor and on paper.

Fonts come in such a variety of formats that problems can sometimes arise. This appendix provides the information you need to avoid such problems and to solve them if they come up.

Kinds of fonts

The Macintosh works with three main kinds of fonts: TrueType, bitmapped, and PostScript fonts.

Apple provides two kinds of fonts with your Macintosh and the Color StyleWriter 1500 printer: TrueType and bitmapped. However, your system can use PostScript fonts as well when it has the proper software installed.
TrueType fonts

A TrueType font is scalable, describing a typeface without rigidly specifying a size. So it looks good whatever size you choose. TrueType fonts provide sharp text at any size on screen or on paper. You can mix and match TrueType fonts from various font vendors.

TrueType fonts store individual text characters as mathematical descriptions of lines and curves, rather than as groups of pixels (a bitmap). When a program asks for a character in a particular size, such as 33 points, the Macintosh uses mathematical calculations to enlarge the character’s outline to 33 points and fill in the dots for the monitor or printer output.

Sometimes you'll still get jagged edges when you print a document, even when you use a TrueType font. In nearly all cases, this is because there isn't enough memory available to scale the font properly for printing. This may happen, for example, when you're running several programs at the same time.

Because you don't need a separate font for each character size in order for your printing to look good (as you do with bitmapped fonts), TrueType font names don't have numbers in them.

How does a font look? To see what a TrueType or bitmapped font looks like on your screen, double-click the font's icon to open it. A sample of that font appears (in three sizes for TrueType fonts and in the size you opened for bitmapped fonts).
You can also use the Key Caps desk accessory to examine fonts. See the documentation that came with your computer for instructions.

**Bitmapped fonts**

Bitmapped fonts consist of "pictures" of a typeface at specific sizes. For example, you might have bitmapped fonts at 10-, 12-, and 18-point sizes installed in your Macintosh computer. For best results you need a separate font file for each size of character you want to use.

The icon of a bitmapped font (also called a fixed-size font or screen font) has the single letter A on it. The font's point size appears at the end of its name.

```
Monaco 12
```

When you request a bitmapped character, your Macintosh looks for an installed bitmapped font in the size you specified. (See "How the Macintosh Looks for Fonts" later in this appendix.) If it can't find that font, your Macintosh tries to construct one by scaling a size that it does find.

In most cases, scaled bitmapped fonts don't look nearly as good as preinstalled ones. Such scaling is one reason for the jagged edges (sometimes called "jaggies") you'll see on your screen or in a printed document when you request an uninstalled size (for example, 17-point Geneva).

Bitmapped fonts are designed on grids of 72 dots per inch (dpi)—the standard Macintosh screen resolution. Because of their correspondence to the standard screen resolution, bitmapped fonts in preinstalled sizes always look great on your display.

When you print a bitmapped font, it prints at a resolution of 72 dpi. Because most modern printers can print at resolutions far better than this (your Color StyleWriter 1500 prints at 360 dpi or better), printed bitmapped fonts almost always have jagged edges or stairstep sides.

Fortunately, the Macintosh can use bitmapped fonts in combination with other font formats, reserving bitmaps for the screen and other kinds of fonts for the printer.
**PostScript fonts**

PostScript is a page-description language that defines the characters, symbols, and images that appear on each page of a document. A PostScript font comes as a pair of fonts: an outline font for the printer and a corresponding bitmapped font for displaying type on your screen.

*No bitmapped font, no menu entry:* If your system doesn't have the bitmapped font, the PostScript font name won't appear in your font menu.

![Cour1](image)

Certain printers are designed specifically to work with PostScript fonts. While your Color StyleWriter 1500 is not a PostScript printer, it can use PostScript fonts if you have Adobe Type Manager software installed. Adobe Type Manager uses printer fonts to generate clean-looking screen text at any size. (This software is included with some installations of system software 7.5. It is available from your local Apple-authorized dealer for version 7.1.)

**IMPORTANT** Adobe Type Manager is not an Apple product. It is made and supported by Adobe Systems Incorporated. Only the version that comes with Apple Macintosh system software version 7.5 is supported by Apple.

PostScript printer fonts have no numbers associated with their names, because a single font can be scaled to any size. Many companies make PostScript fonts; the following illustration shows icons for Adobe, Bitstream, and Fontek PostScript fonts, plus a generic PostScript font icon.

![Font icons](image)

**QuickDraw GX imaging technology**

A QuickDraw GX font is a TrueType or PostScript font with an additional set of sophisticated features. These features include extremely accurate typographic elements such as ligatures and kerning, plus the ability to skew, rotate, and add perspective to text in extremely flexible ways.
How TrueType fonts work with other kinds of fonts

Although TrueType fonts offer distinct advantages, your Color StyleWriter 1500 printer can also use other kinds of fonts.

TrueType and bitmapped fonts

Macintosh computers running System 7 come with both bitmapped (screen) fonts and TrueType fonts installed. This maintains consistency with documents created on Macintosh systems that don't have TrueType fonts.

Bitmapped fonts look better displayed on the monitor, while TrueType fonts look better on a high-resolution printer such as the Color StyleWriter 1500. So, if you have both versions of the font available, the Macintosh uses the bitmapped version when displaying the font on the screen (provided that the size you're using is available) and the TrueType version when printing the font on the Color StyleWriter 1500. To force the Macintosh to use only TrueType fonts everywhere, you must remove the bitmapped fonts.

For example, if a document uses 12-point Times®, available in that size as a bitmapped font and as a TrueType font, the system uses the bitmapped font on the screen and the TrueType font on the printer. If a document uses 4-point Times, the system scales the TrueType font to that size for both the screen and the printer, because a bitmapped version isn't available.
Using only TrueType fonts produces a closer match between the appearance of type on the screen and on paper. However, a document you’ve already created with bitmapped fonts will be reformatted with the corresponding TrueType fonts, and line breaks in the document may change. Similarly, if a document is created on a system that has TrueType fonts or Adobe Type Manager software installed, it may have different spacing, kerning, and so on, when opened on a system that doesn’t have TrueType fonts or Adobe Type Manager software.

**Keeping two font versions available**

If you have a TrueType version of a font, you don’t need a bitmapped version. However, although keeping both versions of a font takes up more disk space, there are several advantages to doing so.

Bitmapped fonts are hand-designed: a graphic artist planned each character in each font to look good on a screen. TrueType fonts are scaled by the computer to match what you request. At smaller point sizes, the bitmaps may appear sharper.

Additionally, scaling fonts takes time—sometimes up to several seconds in slower Macintosh computers—but all Macintosh computers can display a bitmapped font instantly.

**TrueType and PostScript fonts**

PostScript fonts were designed as fonts for PostScript printers. The Color StyleWriter 1500 wasn’t designed to use PostScript. However, if you have Adobe Type Manager software installed, your computer can both display and print PostScript fonts.

*Use different names:* To avoid confusing the printer software, be sure that you don’t install both TrueType and PostScript versions of the same font. For example, do not have a PostScript font file called Times and a TrueType font file called Times installed in your system at the same time.
How the Macintosh looks for fonts

Here's the search order your Macintosh uses to determine which font to display on your screen when you choose a specific size:

1. an installed bitmapped font in that size, if one exists
2. a scaled TrueType font, if no bitmapped font exists
3. an Adobe Type Manager (ATM) version of a PostScript font, if ATM is installed and if no TrueType version exists
4. a scaled bitmap if no ATM font exists

Here's the search order it uses to determine which font to print on your Color StyleWriter 1500 printer:

1. a scaled TrueType font, if one exists
2. an ATM version of a PostScript font, if ATM is installed and if no TrueType version exists
3. a scaled 72-dpi bitmap if no ATM font exists
Where fonts are stored

All fonts for your Color StyleWriter 1500 printer reside in special places within the System Folder. To install fonts, you drag them to the System Folder. Your Macintosh will automatically put them where they belong—in the Fonts folder within the System Folder.

The Fonts folder can contain a total of 128 font suitcases (described in the next section), plus any number of PostScript fonts, up to the available storage capacity of your hard disk.

IMPORTANT Fonts installed in other folders or in the top level of the System Folder may not work correctly. Additionally, bitmapped and TrueType fonts stored outside of suitcases may not work correctly.
Suitcases

A font suitcase is a special folder for collections of fonts.

Suitcases provide a convenient way to organize fonts in the same font family. For example, it's a good idea to use a single suitcase (called Courier) for all fonts in the Courier font family—all Courier roman fonts as well as fonts with names like Courier Bold and Courier Oblique.
Combining suitcases: To merge all the fonts from one suitcase with another, drag one suitcase on top of the other. All the fonts from the dragged suitcase will go into the other, and the dragged suitcase will disappear.

Note: To avoid confusion, rename a font suitcase whenever you put more fonts into it. For example, if you decide to merge Helvetica, Helvetica Black, and Helvetica Compressed, name the suitcase something like “Helvetica Regular/Black/Condensed.”

A suitcase can also contain fonts from different font families, although you should keep all fonts of the same family in the same suitcase. All the fonts will still appear in menus with their proper names.

You treat a suitcase as you would a folder. To open a suitcase, you double-click it. To add a font, you drag the font’s icon to the suitcase and drop it in. To remove a font, you drag its icon out of the suitcase.

To create a font suitcase, duplicate an existing one and throw away its contents. Then rename the suitcase as appropriate and drag whatever fonts you want into it.

You cannot have more than 128 font suitcases in the Fonts folder.

Size limits for suitcases: No matter how many fonts you have in a single suitcase, the Fonts folder counts the suitcase as a single unit. There’s no limit to the number of fonts in a single suitcase, but the suitcase cannot be larger than 16 megabytes.
Most fonts that come with your Color StyleWriter 1500 printer have defined styles. For example, if you open the Bookman font (contained in a suitcase in the Fonts folder, which is inside your System Folder), you see files for bold and italic versions of the font.

But fonts such as Chicago, Geneva, Monaco, and New York do not come with defined styles. If you open the Chicago font suitcase, you see only one file.

You can apply a style to a font like this by making a choice from the appropriate menu (Fonts, Style, Format, or some similar menu, depending on the application program). A font predesigned with a given style nearly always looks better than a font with a computer-generated "derived" style.

About style names: Predesigned styled fonts sometimes have names you may not be familiar with. For example, roman refers to a font without styling, or plain. Oblique is similar to italic. Light, demi, and extra are different kinds of bold.
Common questions about fonts

Here are some questions that often come up about fonts.

What kind of fonts should I buy?

Using a font that has both bitmapped and TrueType versions works best. The bitmapped version looks great on the screen and the TrueType fonts print beautifully on the Color StyleWriter 1500.

Avoid bitmapped fonts that don't have TrueType versions because they print with jagged edges on the Color StyleWriter 1500. By contrast, TrueType fonts work well, even if you don't have a bitmapped version.

If you have a PostScript printer or Adobe Type Manager, PostScript fonts look great on paper. The Color StyleWriter 1500 is not a PostScript printer.

People who need professional typographic features such as swash characters and proportional space numerals might also consider using QuickDraw GX and QuickDraw GX TrueType fonts.

Why don't all of my fonts appear in the Fonts menu?

You may not have all of your fonts placed correctly. All the fonts should be installed in the Fonts folder in the System Folder.

Additionally, some application programs let the user decide which fonts should appear in the Fonts menu. Check the manuals that came with your programs.

Why can't I see my Monaco 9, Geneva 9 and 12, and Chicago 12 bitmapped fonts?

These fonts are used by your Macintosh to display information. Because the Macintosh needs these fonts, the Finder makes them invisible to prevent users from removing them.
What does the term *Apple classic fonts* mean?

The Apple classic fonts are the original ten bitmapped fonts that came with the first Macintosh in 1984. These fonts, which all have city names, include Athens, Cairo (a picture font), Chicago, Geneva, London, Los Angeles, Monaco, New York, San Francisco, and Venice. Several of the fonts (Athens, Cairo, London, and San Francisco) came in only one size—18 points.

*This is a sample of Athens.*

*This is a sample of Chicago.*

*This is a sample of Geneva.*

*This is a sample of London.*

*This is a sample of Los Angeles.*

*This is a sample of Monaco.*

*This is a sample of New York.*

*This is a sample of San Francisco.*

*This is a sample of Venice.*

Chicago, Geneva, Monaco, and New York are currently available in TrueType versions. The other classic fonts are still only available in bitmapped versions.

**Why do I sometimes get Geneva or Courier in my printed documents when I have specified other fonts?**

Geneva sometimes appears when you're trying to use a TrueType font but don’t have enough memory for scaling to operate properly.

Substitute fonts can also appear in a document composed on one Macintosh that has a particular set of fonts but printed on another Macintosh that doesn't have those fonts.

**Why does a document written entirely in Times look different on different Macintosh computers?**

Times, an extremely popular font, is manufactured and sold by more than one company. Such fonts usually have small differences, even though they have the same name. For example, the Times font manufactured by Adobe Systems Incorporated has different letterspacing than does the Times font from Apple Computer, Inc.
What is font substitution?

Font Substitution, which isn't available for your Color StyleWriter 1500 printer, is an option in the Page Setup dialog box for certain PostScript printers. When font substitution is turned on, these printers will use their built-in equivalents for three bitmapped fonts (Times for New York, Helvetica for Geneva, and Courier for Monaco).

What's a downloadable font?

A downloadable font is a TrueType or PostScript font sent to some kinds of printers, such as most PostScript Laser printers, by your system software. The printer then uses the font to print your document.

If a printer has sufficient memory, it can hold more than one downloaded font; otherwise, it must request the fonts it needs as necessary. This can be a time-consuming process.

Some printers have hard disks attached to them for holding downloaded fonts. A printer can get the fonts from its hard disk more quickly than it can download them from the computer's hard disk.

Your Color StyleWriter 1500 printer cannot receive downloaded fonts. Instead, your Macintosh composes the entire image and then sends it to your Color StyleWriter 1500 for printing.
Appendix C
Font List

Between the fonts that come with your Macintosh and those that come with the printer, there are 28 font families (and 64 total styled fonts) available as soon as you install the Color StyleWriter 1500 software.

<table>
<thead>
<tr>
<th>Name in Font menu</th>
<th>Number of fonts</th>
<th>Font family (and styled fonts)</th>
<th>Comes with</th>
</tr>
</thead>
<tbody>
<tr>
<td>Avant Garde</td>
<td>4</td>
<td>ITC Avant Garde* (plain, italic, bold, and bold-italic)</td>
<td>Color StyleWriter 1500</td>
</tr>
<tr>
<td>Bookman</td>
<td>4</td>
<td>ITC Bookman* (plain, italic, bold, and bold-italic)</td>
<td>Color StyleWriter 1500</td>
</tr>
<tr>
<td>Chicago</td>
<td>1</td>
<td>Chicago</td>
<td>Macintosh</td>
</tr>
<tr>
<td>Courier</td>
<td>4</td>
<td>Courier (plain, italic, bold, and bold-italic)</td>
<td>Macintosh</td>
</tr>
<tr>
<td>DELPHIAN</td>
<td>1</td>
<td>Delphian</td>
<td>Color StyleWriter 1500</td>
</tr>
<tr>
<td>Garamond Narrow</td>
<td>4</td>
<td>ITC Garamond* Narrow (plain, italic, bold, and bold-italic)</td>
<td>Color StyleWriter 1500</td>
</tr>
<tr>
<td>Geneva</td>
<td>1</td>
<td>Geneva</td>
<td>Macintosh</td>
</tr>
<tr>
<td>Helvetica</td>
<td>4</td>
<td>Helvetica* (plain, italic, bold, and bold-italic)</td>
<td>Macintosh</td>
</tr>
<tr>
<td><strong>Helvetica Black</strong></td>
<td>2</td>
<td>Helvetica Black (plain and italic)</td>
<td>Color StyleWriter 1500</td>
</tr>
<tr>
<td>Helvetica Compressed</td>
<td>2</td>
<td>Helvetica Compressed (plain and italic)</td>
<td>Color StyleWriter 1500</td>
</tr>
</tbody>
</table>

(continues)
<table>
<thead>
<tr>
<th>Name in Font menu</th>
<th>Number of fonts</th>
<th>Font family (and styled fonts)</th>
<th>Comes with</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lubalin Graph</td>
<td>4</td>
<td>ITC Lubalin Graph(^{\text{®}}) (plain, italic, bold, and bold-italic)</td>
<td>Color</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>StyleWriter 1500</td>
</tr>
<tr>
<td>Lucida Bright</td>
<td>4</td>
<td>Lucida Bright (plain, italic, bold, and bold-italic)</td>
<td>Color</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>StyleWriter 1500</td>
</tr>
<tr>
<td>MACHINE</td>
<td>1</td>
<td>ITC Machine(^{\text{®}})</td>
<td>Color</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>StyleWriter 1500</td>
</tr>
<tr>
<td>Monaco</td>
<td>1</td>
<td>Monaco</td>
<td>Macintosh</td>
</tr>
<tr>
<td>N Helvetica Narrow</td>
<td>4</td>
<td>Helvetica Narrow (plain, italic, bold, and bold-italic)</td>
<td>Color</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>StyleWriter 1500</td>
</tr>
<tr>
<td>Nadianne</td>
<td>2</td>
<td>Nadianne (plain and bold)</td>
<td>Color</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>StyleWriter 1500</td>
</tr>
<tr>
<td>New Century Schoolbook</td>
<td>4</td>
<td>New Century Schoolbook (plain, italic, bold, and bold-italic)</td>
<td>Color</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>StyleWriter 1500</td>
</tr>
<tr>
<td>New York</td>
<td>1</td>
<td>New York</td>
<td>Macintosh</td>
</tr>
<tr>
<td>Old English Text</td>
<td>1</td>
<td>Old English Text</td>
<td>Color</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>StyleWriter 1500</td>
</tr>
<tr>
<td>Onyx</td>
<td>1</td>
<td>Onyx</td>
<td>Color</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>StyleWriter 1500</td>
</tr>
<tr>
<td>Oxford</td>
<td>1</td>
<td>Oxford</td>
<td>Color</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>StyleWriter 1500</td>
</tr>
<tr>
<td>Palatino</td>
<td>4</td>
<td>Palatino(^{\text{®}}) (plain, italic, bold, and bold-italic)</td>
<td>Macintosh</td>
</tr>
<tr>
<td>Swing</td>
<td>1</td>
<td>Swing</td>
<td>Color</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>StyleWriter 1500</td>
</tr>
<tr>
<td>Symbol</td>
<td>1</td>
<td>Symbol</td>
<td>Macintosh</td>
</tr>
<tr>
<td>Times</td>
<td>4</td>
<td>Times(^{\text{®}}) (plain, italic, bold, and bold-italic)</td>
<td>Macintosh</td>
</tr>
<tr>
<td>Zapf Chancery</td>
<td>1</td>
<td>ITC Zapf Chancery(^{\text{®}})</td>
<td>Color</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>StyleWriter 1500</td>
</tr>
<tr>
<td>Zapf Dingbats(^{\text{®}})</td>
<td>1</td>
<td>ITC Zapf Dingbats(^{\text{®}})</td>
<td>Color</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>StyleWriter 1500</td>
</tr>
<tr>
<td>Zeal</td>
<td>1</td>
<td>Zeal</td>
<td>Color</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>StyleWriter 1500</td>
</tr>
<tr>
<td>Total</td>
<td>64</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Appendix D
Working With ColorSync

The Macintosh does a lot of work to make sure that the colors you see on your display closely match the colors you get on your printers, scanners, and other devices. The software that does this work is called ColorSync. Because ColorSync does its work behind the scenes, you don't have to know anything about it. But if you're curious, this appendix explains how ColorSync works and how you can benefit from using it.

The problem that ColorSync solves

Providing consistent color with desktop computers is a technical challenge. Reproducing colors consistently from device to device is difficult because the colored light on your monitor is very different from printed ink. Different color devices use different methods for representing color information and produce different ranges of colors.

Monitors (and most scanners) produce colors by mixing red, green, and blue light—called RGB color. Most printers produce colors by mixing cyan (a shade of blue), magenta (a bright pink), yellow, and black ink. This color system is called CMYK. Since monitors and printers have different color capabilities, they cannot reproduce each other's colors exactly.

In addition, no two monitors or printers produce exactly the same colors. (You can see an example of the differences among monitors at a consumer electronics store, in the section that sells television sets.)
About ColorSync

ColorSync is a system extension that provides color-conversion capabilities and improves color consistency. ColorSync “translates” the colors used on one device so that they match the colors displayed or printed on another device.

ColorSync color conversion is a central part of Macintosh computing, ensuring that applications, monitors, printers, scanners, and digital cameras use the same scheme for color conversion. This means you can scan an image, display it on your monitor, and print it—with visually matching colors every step of the way.

How ColorSync works

ColorSync does not convert colors directly from one device to another. Instead, ColorSync takes information about each device’s color capabilities and compares it to an independent color standard. In this way, it converts the colors produced on one device to closely matching colors that can be reproduced on another device.

ColorSync defines the colors a monitor, printer, scanner, or digital camera can reproduce in a ColorSync profile. ColorSync profiles are compatible with the profile specifications of the International Color Consortium (ICC).
Next, ColorSync converts device-specific colors into standard colors. The CIE color standard describes colors in terms of how they are perceived by the human eye under standardized lighting conditions. (CIE stands for the Commission International de l'Eclairage, the International Commission on Illumination, which founded the standard in 1931.)

To maintain consistency, ColorSync previews a device's color capabilities (in the ColorSync profile) and—where necessary—converts standard colors to closely matching colors that the device can reproduce. For example, your monitor may be able to display a vivid red, but your printer inks may not be able to produce that color. ColorSync determines the “next best” color for your printer to use.

**Using ColorSync**

The ColorSync profile for a device is automatically installed as part of the device's software. To get the best visual color matching on your system, make sure the following display settings are selected:

- For the best color match when printing, select the “page-white” or “D50” system profile for your type of display in the ColorSync System Profile control panel.

- For the best visual match between the colors on your display and printed colors, select the Page-White Gamma option in the Monitors control panel. To select a gamma option, open the Monitors control panel, then hold down the Option key while you click the Options button. In the Options window, click the Use Special Gamma checkbox to put a check in it. Then choose Page-White Gamma from the menu.

- On a multiple scan display, make sure that the color temperature, or intensity, is set to 9300 K (the default setting). See the display manual for instructions. If the Page-White Gamma option is selected with a color temperature other than 9300 K, your monitor colors could look too red or too blue compared to printed colors.

Some color devices allow you to set additional color options that affect the way ColorSync converts colors. See the instructions that came with the device for more information.
Appendix E
Printing with QuickDraw GX

This appendix explains how to use the QuickDraw GX software with the Color StyleWriter 1500. (If you installed QuickDraw GX after you set up your printer, you must reinstall the Color StyleWriter 1500 software.)

Telling your computer to use the Color StyleWriter 1500 with QuickDraw GX

Make sure the printer and your computer are connected and turned on.

1. Select the Chooser from the Apple (⌘) menu.
2. In the Chooser dialog box, use the “Connect via” pop-up menu to choose the appropriate type of connection.

- If the printer is connected directly to your Macintosh with a serial cable, choose Serial.
- If the printer is connected to a Macintosh on the network and is available as a shared device, choose Servers.
- If the printer is connected to the AppleTalk network, choose AppleTalk.

Note: If QuickDraw GX is installed on your Macintosh, background printing is always on and cannot be turned off.
In the Chooser dialog box, click items to select them.

Some Chooser features change, depending on the selection you made in step 2. If you chose Serial in step 2, the Chooser looks like this:

First, click this icon. (If you don’t see the icon, use the scroll bar and arrows to find it.)

Second, click one of these items to indicate which port you connected the printer to: the modem port or the printer port.

Finally, to create a desktop printer, click Create. A printer icon appears on your desktop for easy access.

If no port is available and your computer is a PowerBook, see “Special Information for PowerBook Owners” in the section “Telling Your Computer to Use the Color StyleWriter 1500” in Chapter 1.

If you chose Servers or AppleTalk, the Chooser looks like this:

First, click this icon. (If you don’t see the icon, use the scroll bar and arrows to find it.)

Second, if your network has zones, click the one you want.

Third, click the name of the printer you want to use.

Finally, to create a desktop printer, click Create. A printer icon appears on your desktop for easy access.

If the printer is connected by AppleTalk, you can rename the printer. (Otherwise, this feature is not available.)
4 Close the Chooser dialog box.

If you close the Chooser without creating at least one desktop printer, this message appears.

![Message](image)

To use a printer for which you have no desktop icon, you must select the printer in the Chooser and click Create. If you select the printer but don't click Create, the Chooser ignores the selection.

### Defining the page setup

Most Macintosh programs have a Page Setup command in the File menu. You can use this command to set a variety of options. The most common options are already selected for you, but you can change them if you want to.

1 Choose Page Setup from the File menu.

The Page Setup dialog box appears, as shown in the next step. The dialog box you see may not exactly match any of the illustrations in step 2, but it works basically the same way.

2 In the dialog box, make the selections you want.

If you're working in a program that doesn't take full advantage of QuickDraw GX (is not "GX-savvy"), a dialog box similar to the one below appears.

![Dialog Box](image)

Use this pop-up menu to identify the paper or envelope size you are using.

For vertical orientation (also called *portrait*), click here. For horizontal orientation (also called *landscape*), click here.
If you are using a GX-savvy program, there are two versions of the Page Setup dialog box. This is the basic version:

For vertical orientation (also called **portrait**), click here.

To see the expanded dialog box, click More Choices.

To enlarge or reduce the size of the printed image, select this box and enter a number.

In the expanded dialog box you can select a specific printer.

To format a document for one of the desktop printers you've created, choose the printer from this pop-up menu.

To see the basic dialog box, click Fewer Choices.

---

3. **When you've made your choices, click Format (or OK in a program that's not GX-savvy).**

Your document is now set up for printing.
Printing a document

To print a document, follow these steps:

1. Open the document you want to print, or select its icon in the Finder.

2. Choose Print from the File menu.

A dialog box appears, displaying a number of printing options. The dialog box you see may not exactly match any of the illustrations in step 3, but it works basically the same way. The most common options are already set for you.

3. Set any options you like.

If you're working in a program that isn't GX-savvy, a Print dialog box similar to the one below appears.

Click Best for highest quality, Normal for typical use, or Draft for lower ink consumption. For plain and coated paper, you can use any of these three choices; for other materials, you must use Best quality.

Choose Color, Grayscale, or Black & White from this pop-up menu.

Use this pop-up menu to identify the type of material you've loaded into the printer. (For labels and envelopes, choose Plain.)
If you are using a GX-savvy program, there are two versions of the Print dialog box. This is the basic version:

![Print Dialog Box](image)

To see the expanded dialog box, click More Choices.

In the expanded dialog box you can make additional choices.

![Expanded Print Dialog Box](image)

To display a dialog box that lets you schedule print jobs, click this icon.

The paper-matching feature is useful for printers that have multiple paper trays.

4 When you are satisfied with the settings, click Print.

If necessary, the printer turns itself on and, after a few moments, begins printing your document. Don't open the printer cover while the document is printing. (This can waste ink and cause a paper jam.)
Adjusting quality options

To adjust the way colors are printed, follow these steps:

1. Choose Print from the File menu.
2. Make sure the expanded dialog box appears.
   If necessary, click More Choices.
3. In the expanded dialog box, click the Quality icon and set any options you like.
   Use this pop-up menu to identify the type of material you've loaded into the printer.
   (For labels and envelopes, choose Plain.)
   Choose Color, Grayscale, or Black & White from this pop-up menu.
   The printer blends the ink colors in either a random scattering of dots or a repeating pattern of dots. Choose the method you prefer.

4. When you are satisfied with the settings, click Print.
   If necessary, the printer turns itself on and, after a few moments, begins printing your document. Don't open the printer cover while the document is printing. (This can waste ink and cause a paper jam.)
   If you are still not happy with the quality, try using the regular (non-GX) QuickDraw printing software and see which results you prefer. See "If You Choose Not to Use QuickDraw GX Printing" at the end of this appendix.

Note: If you have a color PowerBook computer, open the ColorSync control panel and make sure the system profile is correct for your PowerBook.
   If it's not, choose Set System Profile from the pop-up menu and select the correct profile.
Cleaning the print head

To clean the print head, follow these steps:

1. **When you are about to print a document, click Utilities in the expanded Print dialog box.**

   ![Utilities dialog box](image)

   **First,** to see the utilities, click this icon. (If you don’t see the icon, use the scroll bar and arrows to find it.)

   **Second,** click to place an X here.

2. **When you are satisfied with the settings, click Print.**

   If necessary, the printer turns itself on and, after a few moments, begins printing your document. Don’t open the printer cover while the document is printing. (This can waste ink and cause a paper jam.)

   *Note:* After the printer cleans the print head and prints your document, the cleaning option is automatically turned off. You don’t have to turn it off before printing again.

A printing shortcut

If you have one or more printer icons on your desktop, you can print a document by dragging its icon to the printer.

For instructions on creating a desktop printer, see “Telling Your Computer to Use the Color StyleWriter 1500 With QuickDraw GX” at the beginning of this appendix.
If you choose not to use QuickDraw GX printing

If you're unhappy with the quality of color printing on your Color StyleWriter 1500, try turning off the QuickDraw GX printing software and using the regular QuickDraw printing software. You can decide which you prefer.

1. **Open a program that's not GX-savvy.**

If you're not sure whether the program is GX-savvy, choose Page Setup from the File menu. If the dialog box that appears looks like the one below, the program is not able to take full advantage of QuickDraw GX.

![Color StyleWriter 1500 GX Page Setup](image-url)

The GX-savvy version of the Page Setup dialog box contains additional features.

2. **Choose Turn Desktop Printing Off from the Apple (Apple) menu.**

A message appears:

![Warning message](image-url)

*Note:* If the message doesn’t mention the Color SW 1500 driver, someone may have removed it from your Macintosh. Use the Custom Install option in the Installer to install the driver. (See “Using the Custom Installer to Solve Installation Problems” in the section “Installation Is Unsuccessful” in Chapter 5.)

3. **Click OK.**

Now your Color StyleWriter 1500 will use the regular QuickDraw printing software. If you want to go back to using the QuickDraw GX printing software, repeat this process, but in step 2 choose Turn Desktop Printing On.
Appendix F
Removing the Desktop Printing Software

The printing software that you installed in Chapter 1 requires that you have at least one printer icon on your desktop. If you don't want to use the desktop printing software, you must remove the desktop printing software, as shown in these steps:

Before you begin: Find the disks that came with the Color StyleWriter 1500.

1. Insert Color StyleWriter 1500 Disk 1 into a floppy disk drive.
   If necessary, open the disk icon.
2. To start the Installer program, double-click its icon.
3. In the Welcome dialog box that appears, click Continue.
4 In the Installer dialog box, choose Custom Remove.

Choose Custom Remove from this pop-up menu.

5 In the Custom Remove dialog box, click the Desktop Printing Software checkbox.

First, click this checkbox. (An X appears to show it's selected.)

Second, make sure the disk named here is the one from which you want to remove the desktop printing software. (If not, click Switch Disk until the correct name appears.)

Finally, when you're ready to begin, click Remove.
6 When you see a message on your screen, follow the directions and insert the next disk. The Installer ejects disks and asks you to insert others. Keep following the instructions on the screen until the process is complete.

7 When you see a message reporting that the process was successful, click Restart. The Installer restarts your Macintosh. When the computer restarts, the desktop printer icons appear with an X on them.

8 After the computer restarts, drag your old desktop printer icons to the Trash.

9 Read the next section to learn how to use the PrintMonitor to monitor and control print requests.
Monitoring and controlling print requests without desktop printers

If you don't have desktop printers, you must use the PrintMonitor program to monitor and control background printing.

1 While your document is printing, choose PrintMonitor from the Application menu at the far right of the menu bar.

2 In the PrintMonitor dialog box, review the status of documents that are printing (and make any changes you want).

3 When you finish, click the PrintMonitor close box.
Appendix G
Packing and Moving the Printer

If you need to move your printer a long distance, follow these steps.

1. Turn off the printer and unplug it.
2. Remove any paper from the sheet feeder.
3. Disconnect the power cord and serial cable.
4. Open the cover and remove the ink cartridge.
5. Seal the ink cartridge tightly in plastic bag.

Ink cartridges can leak if exposed to significant changes in air pressure.
6 Open the cover and tape the carrier to the right side of the printer.

Use masking tape to tape the carrier to the side of the printer.

7 Close the cover.

8 Push the paper support and the output tray back inside the printer.

9 Repack the printer in its original packing material.

When the printer arrives at its new location, unpack it and set it up as described in Chapter 1.
**Index**

**A**
- AC power adapter, power requirements for 84 adapters
- AC power adapter 84
- EtherTalk adapter 48
- Adobe Type Manager 73, 90, 92, 98
- A4 paper 12–13, 83
- alerts when printing is complete 30
- alias for desktop printer icon 40
- Apple classic fonts 99
- Apple menu
  - Chooser 17, 30, 39, 41, 45, 47, 60, 64, 107–109
  - Turn Desktop Printing Off command (QuickDraw GX) 115
- Apple part numbers 82, 85
- Apple System/Peripheral-8 cable 82, 85
- AppleTalk network, sharing printer on 44–47
- AppleTalk zones 108
- Athens font 99

**B**
- background printing 28, 41–43
  - low memory and 71
  - monitoring and controlling 42, 120
  - turning on and off 41
- back-print film 26, 50, 69
- backward print 75
- Best print quality 30, 51
- bitmap 88
- bitmapped font icon 89
- bitmapped fonts 87, 89
  - Apple classic fonts 99
  - benefits of 91–92, 98
  - removing 91
- black and white printing 30
- black ink cartridge, replacing 54
- Bookman font 97, 101
- borders around mini pages 29, 37
- Borders option (Page Setup dialog box) 29, 37
cable, serial 64, 82
  connecting 9
  part number for 85
Cairo font 99
carrier 5, 6
cartridge. See ink cartridge
Chicago font 97, 98, 99, 101
Chooser (Apple menu)
  AppleTalk zones 108
  Color StyleWriter 1500 icon does not appear in 60
  QuickDraw GX and 107-109
  selecting port with 64
  selecting printer with 17, 39
  Share This Printer option 45, 47
  turning background printing on and off with 41
cleaning
  inside of printer 57
  outside of printer 2, 57
  print head 30, 66
    with QuickDraw GX 114
CMYK color 103
closing printer 8
colored paper 50
color ink cartridge, replacing 54
color-matching method, selecting 32-33
Color option (Print dialog box) 30, 32-33
  halftoning option 32, 38
Color Options dialog box
  ColorSync option 32
  Pattern option 32, 38
  Scatter option 32, 38
color printing
  adjusting options for 32-33
  ColorSync and 32-33, 103-105
  halftoning 38
  quirks about 33
  troubleshooting 76, 78
ColorShare 44-47
  print requests and 42
Color StyleWriter 1500 Disk 1 14, 117
Color StyleWriter 1500 Installation
  disk 62
Color StyleWriter 1500-Troubleshooting
  file 19
ColorSync color-matching system 32-33
  how it works 104-105
  problems solved by 103
  using 105
ColorSync option (Color Options dialog box) 32
columns, trouble printing 75
color matching system, using 105
color matching system, using 105
columns, trouble printing 75
color matching system, using 105
columns, trouble printing 75
color matching system, using 105
columns, trouble printing 75
color matching system, using 105
columns, trouble printing 75
computer. See also Macintosh;
  PowerBook; Power Macintosh
  crashes while attempting to print 63
  printing while in use 41-43, 70
  telling to use printer 17, 39
connecting printer
  to Macintosh 9
  to PowerBook 18
connector cable 9, 64, 82, 85
Copies option (Print dialog box) 30
cost-effective printing 52
Courier font 95, 101
cover 4
  closing 8
  keep closed while printing 1
  opening 6
Custom Install (Installer) 16, 62
Custom Remove (Installer) 118
dark images, troubleshooting 76
default desktop printer icon 40
default printer 38-39, 40
desktop
  moving desktop printer icon on 17
  printing from 31
Desktop Printer Extension,
  turning off 65
desktop printer icon
  appearance of 17
  creating 39, 40
  creating alias for 40
  dragging documents to 31, 39
  moving on desktop 17
  printer status indicated by 40
  renaming 40
  selecting as default printer 39
  throwing away 40
  unusual behavior of 65
  X appears on 40, 65
Desktop Printer Spooler, turning off 65
desktop printing software.
  See printer software
Desktop PrintMonitor, turning off 65
dimensions of printer 83
Disabled desktop printer icon 40
disconnecting power 2, 10, 11, 60
distorted images on printed page 80
documents
  dragging to desktop printer icon 39
  failure to print 69
  PICT or PICT2 format 36-37
  planning 23
  printing 27-31
    detailed instructions for 28-31
    multiple copies of a document 30
    multiple documents 31
    quick instructions for 27-28
  troubleshooting 69, 73-75
dots per inch (dpi) 89
downloadable fonts 100
Draft quality printing 52
dragging
  desktop printer icon to Trash 40
  documents to desktop printer icon 31, 39
E
electrical requirements 84
electromagnetic interference 4
end of paper error 71
energy, saving 11
engine speed 81
enlarging printed images 34
envelope icon 24
envelopes
  loading into sheet feeder 24-27
  sheet feeder capacity for 26
  sizes of 83
  troubleshooting 68
  types accepted by printer 83
Error desktop printer icon 40
error messages 64, 70-71.
  See also troubleshooting
EtherTalk Adapter 48
EtherTalk network 48
Executive paper 83
extensions, turning off 14, 65
Extensions Manager control panel 65
external paper selector 4, 12, 13, 24
F
File menu
  Make Alias command 40
  Page Setup command 19, 23, 29, 109
  Print command 19, 27, 30, 52
  Quit command 20
files, PICT or PICT2 format 36.
  See also documents
film. See back-print film
Finder, printing from 31
fixed-size fonts. See bitmapped fonts
fonts 87–100
  Apple classic 99
  Athens 99
  bitmapped 87, 89, 91–92, 98, 99
  Bookman 97, 101
  Cairo 99
  Chicago 97, 98, 99, 101
  Courier 95, 101
  downloadable 100
  Geneva 97, 98, 101
    unexpected appearance of 73, 99
how the Macintosh looks for 93
  installing 94
  invisible 98
  list of 101–102
  London 99
  Los Angeles 99
  Monaco 97, 98, 99
  New York 97, 99
  organizing 95
  PostScript 87, 90, 92
  purchasing 98
  purpose of 87
  questions and answers about 98
  QuickDraw GX 90
  removing from Fonts folder 61
  San Francisco 99
  scalable 88
  scaling 92
  size of 88
  specifications for 82
  storage of 94
  styled fonts 97
  style names for 97
  substitute 99, 100
  suitcases for 95–96
  Times 91, 92, 99
  troubleshooting 98–99
  TrueType 87, 88, 91–92, 98
  types of 87, 98
  Venice 99
  viewing samples of 88–89

fonts folder in System Folder
  capacity of 94
  installing fonts in 94, 98
  removing items from 61
Fonts menu 98
font substitution 100
front cover. See cover
fuzzy print 76

G
Geneva font 97, 98, 101
  unexpected appearance of 73, 99
glossy paper 26, 50
graphics, failure to print 73
grayscale printing 30

H
halftoning 32, 38
horizontal page orientation 109–110

I
icons
  alias for 40
  bitmapped fonts 89
  Color StyleWriter 1500 printer 60
desktop printer 17, 30, 31, 38–39, 65
document, dragging to desktop printer
    icon 31, 39
document
  envelope 24
  font suitcase 95
Installer 14
  modem port 9
moving 40
  moving on desktop 17
  paper 24
PostScript font 90
renaming 40
serial port 9
throwing away 40
TrueType font 88
light printed images 76
lines or stripes on printed page 79
loading sheet feeder. See sheet feeder
logging printer usage 46
logos, watermarks of 36
London font 99
Los Angeles font 99
low memory 70, 72, 73

M

Macintosh. See also computer;
PowerBook; Power Macintosh
connecting printer to 9
failure to recognize the Color
StyleWriter 1500 printer 64-65
fonts and 87–100
how it looks for fonts 93
sharing printer connected to 44–47
maintenance 53–57
checking print nozzles 21–22
cleaning inside of printer 57
cleaning outside of printer 57
replacing ink cartridge 54–56
storing unused ink cartridges 55
Make Alias command (File menu) 40
marking engine 81
Matching Method pop-up menu 33
memory
background printing and 70, 72
low 70, 72, 73
requirements x
virtual 5, 63, 72
menus
Apple menu 17, 39, 41, 115
File menu 19, 20, 23, 27, 29, 30, 40, 52, 109
Fonts menu 98
Matching Method pop-up menu 33
Printer Profile pop-up menu 33
Printing menu 39, 43
messages on screen 70–71.

See also troubleshooting

J, K

jagged print 73, 88, 89, 98
jammed paper 67

L

labels 26, 69
landscape page orientation 109–110
Layout option (Page Setup dialog box)
23, 29, 37
legal-size paper 83
letterhead paper, loading into sheet
feeder 24
letter-size paper 83
mini pages 29, 37
misfeeds, preventing 50
modem, PowerBook Express 18
modem port 9, 17
modem port icon 9
Monaco font 97, 98, 99
monitor, system profile for 32–33
moving
desktop printer icon 17
printer 121–122

N
naming
desktop printer icon 40
font suitcases 96
networks. See AppleTalk; Ethernet;
shared printer
New York font 97, 99
No paper or Wrong Paper Size message 71
Normal print quality 52
Notification option (Print dialog box) 30
nozzles. See print nozzles

O
off-center print 74
opening printer 6
operating environment 110
orientation, vertical or horizontal 109–110
Orientation option (Page Setup dialog box) 23, 29, 109
output tray 25
overhead transparencies.
See transparencies

packing and moving the printer 121–122
packing materials, removing 3
page breaks, unexpected changes in 29, 34, 38, 74
page orientation 23, 29, 109
Page Setup command (File menu) 19, 23, 29, 109
Page Setup dialog box
Borders option 29, 37
Layout option 23, 29, 37
Orientation option 23, 29, 109
Page Size option 23, 29
QuickDraw GX-savvy programs 110
Scaling (%) option 23, 29, 34
Watermark option 29, 34–37
Page Size option (Page Setup dialog box) 23, 29
Pages option (Print dialog box) 30
pagination, changes in 29, 34, 38, 74
paper. See also print materials
A4 12–13, 83
coated 50
glossy 26, 50
indicating size of 19, 23, 25, 29
indicating type of 25
jams 67
letterhead 24
loading into sheet feeder 12–13, 24–27
troubleshooting 68–69
misfeeds 68–69
orientation of 23, 27, 29, 109
part numbers for 85
plain 26, 49
premium coated 26, 50
saving 37
sizes of 23, 26, 29, 82
three-hole punched 24
types to use 49–50
U.S. legal-size 83
U.S. letter-size 12–13, 83
watermarks on 29, 34–37, 75
paper guide 4
paper icon 24
paper jams 67
paper selector
  external 4, 12, 13, 24
  internal 5, 12, 25
paper support 4, 24
Paper Type option (Print dialog box) 30
part numbers 85
password for shared printing 45
Pattern option (Color Options dialog box)
  32, 38
PICT or PICT2 format files 36–37
platen, cleaning 57
plugging in printer 10
portrait page orientation 27, 109
ports
  modem 9, 17
  printer 17
  serial 5, 9
    in use by another application 70
      on PowerBook 18, 65
    selecting in Chooser 64
PostScript font icon 90
PostScript fonts 87, 90, 92
PostScript printer 98
power
  connecting 10
  consumption of 84
  disconnecting 2, 10, 11, 60
  saving 11
power adapter 10
PowerBook
  connecting printer to 18
  saving print requests on 43
  serial port on 18, 65
  trouble printing to the Color
    StyleWriter 1500 printer 63
PowerBook Express Modem 18
power button 4
power cord 2, 10
power light, problems signaled by 65
Power Macintosh
  trouble printing to the Color
    StyleWriter 1500 printer 63
  Virtual Memory and 5, 63
power requirements of AC power adapter 84
power socket 5
power supply 84
Preferences folder in System Folder 37
premium coated paper 26
printable area 83
Print command (File menu) 19, 27,
  30, 52
Print dialog box
  Color option 30, 32–33, 38
  Copies option 30
  Image option 30
  Notification option 30
  Pages option 30
  Paper Type option 30
  Print Quality option 30, 52
  QuickDraw GX-savvy programs 113
  Utilities option 30
printer. See also desktop printer icon;
  printing or specific topic
  back view of 5
  cleaning inside of 57
  cleaning outside of 2, 57
  closing 8
  connecting to EtherTalk network 48
  connecting to Macintosh 9
  connecting to PowerBook 18
  default or not default 38–39, 40
  determining status of by looking at its
    icon 40
  dimensions of 83
  features of ix
  front view of 4
  installing ink cartridge in 6–8
  interior view of 5
  location for 4
  logging usage of 46
  maintenance of 53–57
opening 6
operating environment for 84
options for 85
packing and moving 121–122
plugging in 10
resetting 65
selecting in Chooser 17, 39
serial number of 5
setting up 1–22
sharing 42–43, 44–47
speed of 52, 66
storage environment for 84
switching between printers 38–39
system requirements for x
technical specifications for 81–85
telling computer to use 17, 39
turning off 60
turning on and off 11
turns on automatically 28
troubleshooting 59–80
unpacking 3–4
unplugging 2, 10, 11
weight of 83
printer icon. See desktop printer icon
printer port 17
Printer Profile pop-up menu 33
printer software
changes to x
corrupted 63
installing 14–16
Custom Install 62
troubleshooting 60–63
removing 117–120
watermarks and 36
print head 6, 54
cleaning 30, 66, 114
do not touch 56
printing. See also printer; print materials;
print requests; troubleshooting
or specific topic
background 28, 41–43, 71, 120
back-print film 26, 50, 69
Best quality 30, 51
black and white 30
borders on mini pages 29, 37
Color StyleWriter 1500–
Troubleshooting file 19
color 32–33, 38, 103–105
troubleshooting 76, 78
columns 75
cost of 52
desktop printing 31
Draft quality 52
enlarged images 34
envelopes 24–27, 68
fonts 87–100
from Finder 31
gray scale 30
halftoning 32, 38
instructions for
detailed 28–31
quick 27–28
labels 26, 69
layout of 23, 29
logging 46
long drafts 37
mini pages 29, 37
multiple copies of a document 30
multiple documents 31
Normal quality 52
notification when printing is
complete 30
options for 23, 29
orientation of 23, 29, 109
page ranges 30
planning documents for print 23
quality of 30, 51, 52, 76
reduced images 34
shared 42, 44–47
troubleshooting 64
special effects 34–38
specifying print quality 30
speed of 52
standard documents 27–28
switching between printers 38–39
test page 21–22
transparencies 26, 50, 69, 82
watermarks 29, 34–37
while computer is in use 41–43, 70
whole document 30
with QuickDraw GX 107–115
Printing menu
Set Default Printer command 39
Set Print Time command 43
Stop Print Queue command 43
Printing Prefs folder 37
print materials. See also back-print film;
envelopes; labels; paper;
transparencies
choosing 49–51
loading into sheet feeder 24–27
part numbers for 85
types not to use 49–50
types to use 26, 49, 82
weights of 82
PrintMonitor program x, 120
print nozzles
checking 21–22
do not touch 56
print quality
Best 30, 51
Draft 52
Normal 52
QuickDraw GX and 113
specifying 30
troubleshooting 76
Print Quality option (Print dialog box)
30, 52
print requests to shared printers
changing order of items waiting to print 43
closing 8
ColorShare and 42
deleting 42
indicating urgency of 43
monitoring and controlling without
desktop printer 120
moving request from one printer to another 43
opening 6
putting on hold 43
saving on PowerBook 43
setting print time for 43
sorting list of documents waiting to
print 43
stopping documents from being
printed 43
troubleshooting 59–80
problems. See troubleshooting

Q

quality of print 51
QuickDraw GX software 14–16, 90
cleaning print head with 114
defining page head 109–110
printing with 107–115
shared printer and 44, 64
telling computer to use 107–109
turning computer to use 107–109
Quit command (File menu) 20
R

RAM. See memory
reducing printed images 34
relative humidity for printer 84
renaming
desktop printer icon 40
font suitcases 96
printer on EtherTalk network 48
repair 59
replacing ink cartridges 54–56
resetting printer 65
resolution 81, 89
RGB color 103
rollers, cleaning 57

S

safety instructions 1–2, 60
San Francisco font 99
saving watermarks 37
scalable fonts 88
scaling fonts 92
Scaling (%) option (Page Setup dialog box) 23, 29, 34
scaling options for watermarks 35–36
Scatter halftoning option (Color Options dialog box) 32, 38
screen fonts. See bitmapped fonts
screen resolution 81, 89
selecting printer in Chooser 17, 39
serial cable 64, 82
connecting 9
part number for 85
serial number 5
serial port
in use by another application 70
on Macintosh 5, 9
on PowerBook 18, 65
serial port icon 9
service 59
Set Default Printer command (Printing menu) 39
Set Print Time command (Printing menu) 43
setting up printer 1–22
shared printer
ColorShare and 42, 44–47
logging usage of 46
password for 45
printing on 47
print request to 42
QuickDraw GX and 64
setting up for 44–46
troubleshooting 64
Share This Printer option (Chooser) 45, 47
sheet feeder
capacity of 26, 68, 82
loading 24–27
back-print film 50, 69
envelopes 68
glossy paper 50
labels 69
paper 12–13, 68–69
transparencies 50, 69
removing packing materials from 3
troubleshooting 67–69
slow print speed 66
smeared ink 77
software. See Adobe Type Manager;
printer software; PrintMonitor;
QuickDraw GX
special effects 34–38
specifications 81–84
speed of print 52
stains on printed page 80
Start Print Queue command (Printing menu) 43
Stopped desktop printer icon 40
Stop Print Queue command (Printing menu) 43
storing
fonts 94
ink cartridges 55
printer 84
styled fonts 97
style names for fonts 97
substitute fonts 99, 100
suitcases for fonts 95–96
switching between printers 38–39
system failure while attempting to print 63
System Folder
  Fonts folder in 61, 94, 98
  Preferences folder in 37
system requirements x
system software, upgrading 14

T
teachnical information 81–85
temperature for printer 84
test page, printing 21–22
three-hole punched paper, loading into sheet feeder 24
Times font 91, 92, 99
transparencies
  loading into sheet feeder 50, 69
  sheet feeder capacity for 26
type to use 50, 82
Trash, dragging desktop printer icon to 40
troubleshooting 59–80
  backward print 75
  Chooser doesn’t show Color StyleWriter 1500 icon 60
  columns 75
colors don’t look right on printed page 78
colors skip or streak at bottom of page 76
computer crashes while attempting to print 63
dark images 76
desktop printer icons behave unusually 65
documents do not print as expected 73

font changes to Geneva 73, 99
fonts 98–99
fuzzy print 76
horizontal white lines or stripes appear on printed page 79
image prints wavy or distorted 80
image too light or too dark 76
ink cartridges run out of ink too quickly 80
ink smears when rubbed 77
installation is unsuccessful 60–63
jagged print 73, 88, 89, 98
light images 76
Macintosh doesn’t recognize the Color StyleWriter 1500 printer 64–65
memory is low 72–73
messages appear on computer screen 70–71
misfeeds, preventing 50
more than one piece of paper passes through printer at a time 67
off-center print 74
page breaks change unexpectedly 74
dark images 76
paper jams 67
paper or envelopes feed improperly 68–69
pictures fail to print 73
poor print quality 76
PowerBook has trouble printing to the Color StyleWriter 1500 printer 63
power light indicates a problem 65
Power Macintosh has trouble printing to the Color StyleWriter 1500 printer 63
printer acts as if it’s working, but nothing is printed on page 70
printer software installation 16, 60–62
printer won’t print a particular document 69
printing appears on only part of the paper 77
printing the Color StyleWriter
1500-Troubleshooting file 19
safety precautions 60
shared printer 64
sheet feeder 67-69
slow print speed 66
stains on printed page 80
text lines up in columns on screen but
not when it prints 75
text prints but pictures do not 73
thin lines fade or break up 77
waste ink container is full 70
watermarks 75
when to pull the plug 2
TrueType font icon 88
TrueType fonts 87, 88, 91-92, 98
forcing Macintosh to use 91
how they work with other kinds of
fonts 91-92
Turn Desktop Printing Off command
(Apple ⌘ menu) 115
turning extensions off 14, 65
turning printer off 60
turning printer on and off 11
turning printer on automatically 38
turning QuickDraw GX printer software
off 115
typeface. See fonts

V
Venice font 99
vertical page orientation 109
Virtual Memory 5, 63, 72

W, X, Y, Z
warranty 59
waste ink container, full 70
watermark 29, 34-37
choosing from menu 35
creating your own 36-37
density of 35
placement of 35-36
printer software and 36
saving 37
scaling options for 35-36
troubleshooting 75
Watermark option (Page Setup dialog
box) 29, 34-37
wavy images on printed page 80
weight of printer 83
white lines or stripes on printed page 79

U
U.S. legal-size paper 83
U.S. letter-size paper 12-13, 83
unpacking printer 3-4
unplugging printer 2, 10, 11, 60
upgrading system software 14
Utilities option (Print dialog box) 30